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About the Name

Why the name “Eudora”?

When I was looking for a name for my new Post Office Protocol mail program,
I thought immediately of the title of a short story I’d read years before:
“Why I Live at the P.O.”  So I named the program after the author of the
story, Eudora Welty.

“Why I Live at the P.O.” can be found in a collection titled A Curtain of
Green  (Harcourt Brace Jovanovich).  I highly recommend reading it, and
anything else you can find by Ms. Welty.  Her stories are funny, sad, and
fascinating; she’s surely one of the great American writers.

                — Steve Dorner

September 1995
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Getting Started

System Requirements

In order to use the Eudora electronic mail (e-mail) program (hereafter referred to
as Eudora), the following system requirements must be satisfied:

❏ IBM PC or compatible (minimum 286 processor)

❏ Microsoft Windows 3.1 or later

❏ Ethernet card or modem for serial connection

❏ WinSockAPI 1.1 compliant networking package

❏ Account on a computer with a Post Office Protocol version 3 (POP3) server

Installing Eudora

Install Eudora as follows:

1.  Create a new directory on your PC for the Eudora files (C:\EUDORA is a
good choice).

2.  Copy the Eudora Light executable file (EUDORA.EXE) and help file
(EUDORA.HLP) into the directory you created in step 1.

3.  Add the following environment variable to your AUTOEXEC.BAT file:

SET TMP=C:\TMP (or some temp directory)

Make sure that this directory exists.
4.  Run Windows and add Eudora as a Program Item to a new or existing

Program Group.
If you want your mail files to reside somewhere other than where the executable
resides, then you can set the mail directory by specifying the directory as the first
parameter on the command line of the Program Item that you create for Eudora.

This is also useful if you want to have multiple users on one PC, each with their
own mail directory.  Eudora will use the directory on the command line first.  If
that isn't present, the directory where the executable resides will be used.

Note:   Always keep the Help file in the same directory as the executable.
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Eudora Configuration

After you have installed Eudora, double-click on its icon to open the program.
Before you can actually use Eudora, you must give it some necessary pieces of
information.  To enter this information, select Settings... from the Special menu.
The Settings dialog is then displayed with the Getting Started settings selected.

The Settings dialog (Getting Started)

To use Eudora, you must have an account on a computer that runs a POP3 server.
This is the account to which your e-mail messages are delivered before they are
transferred to the Eudora program on your PC.  In the POP Account field, type
your login name for this account and the full (domain) name of the computer,
separating them with an “@” sign.  For example, if your assigned login name is
“jbdorn,” and the name of the computer where you receive e-mail is
“awesome.com,” type “jbdorn@awesome.com” in this field.

In the Real Name field, type your real name.  Your name, as it appears here, is
displayed in parentheses after your return address in your outgoing mail.  It is
also displayed in the sender column of all messages sent by you.

For a quick introduction to the program’s basic functions, see the Tutorial chapter
of this document; for detailed explanations of all available Eudora functions, see
the Reference chapter.
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Tutorial

Introduction

This tutorial introduces Eudora’s basic functions.  There are a host of other
operations that are not described here.  For detailed explanations of all available
Eudora functions, see the “Reference” chapter of this document.

Getting Help

Look in this manual for the information you need by using the “Index” and
“Table of Contents.” If you still have unanswered questions, contact your
company’s Eudora support coordinator.

To Find out how to use your keyboard to enter Eudora commands (as opposed to
selecting the command in the Eudora interface), select Contents from the Help
menu and click Shortcut Keys.

Creating an Outgoing Message

A good way to familiarize yourself with Eudora is to create an outgoing message.
An outgoing message is one that you send to someone else.

From the Message menu, select New Message.  A new composition window is
displayed with the blinking caret situated at the start of the To: field.

Composition window

Since it is easiest to experiment with Eudora by sending a message to yourself,
type your own e-mail address in the To: field.

Note that the From: field has been automatically filled in (and can’t be altered).
This is the message return address; it should be your own POP3 server account
address.
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Press the [tab] key or point and click the mouse to move the caret down to the
Subject: field.  Typically, this field should contain some brief text indicating what
the message is about.  For this message, type the words Test Message.

Move the caret past the remaining Cc:, Bcc:, and Attachments: fields down into
the large area below them.  This area is reserved for the actual body of the
message.  Here you may type in whatever text you want.  When you finish your
message (referred to throughout this tutorial as your test message) the
composition window should look something like the example below.

Example test message, ready to send

Sending a Message

Notice the Send button in the upper right hand corner of the composition window.
To send a message in its current state, simply click on this button.  Click it now.

Clicking the Send button

The composition window immediately closes, and the progress window is
momentarily displayed at the top of the screen.  Eudora uses the progress window
to report on the progress of lengthy operations.  In this case, it indicates that the
message is being transferred out onto the network.

Progress Window

Eudora’s Progress window includes a Stop button.  In addition, the Progress
window can be moved around in the main window and will display in the same
location each time (until you relocate it).
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The Progress window

Checking for and Receiving Mail

There are two ways to check your POP server to see if you have any new mail.
One way is automatic and is determined by the Check for mail every ? minutes
option in the Settings dialog (Checking Mail).  The alternative is to check for
mail manually whenever you want by selecting Check Mail from the File menu.
Do this manual check now.

Each time the Eudora program is opened, your password is requested prior to the
first mail check, whether it is conducted automatically or manually. Upon the first
check, such as now, a dialog is displayed requesting the password of your POP
account.

Note: Your POP account password is provided to you by your company’s
Eudora support coordinator.

Password dialog

Type in the password and click OK.  If you make a mistake before clicking OK,
simply backspace and re-enter the password correctly.  If your password is
rejected, repeat the manual check by selecting Check Mail from the File menu
and re-entering your password.

Note: Remember that the Eudora password may be case-sensitive
(depending on your POP server), so it must be typed in exactly or
it is rejected.  If you are having trouble entering your password,
verify that the [Caps Lock] key is off.

After successfully entering your password, a progress window is momentarily
displayed at the top of the screen indicating that an attempt to reach your POP
account is being made.
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Progress window

If there is a network problem between you and the POP server, an alert is
displayed (see below).  Consult with your Eudora support coordinator to rectify
the problem.

Problem transferring mail

Note: If you ever have a problem of this type, the numbers in the []’s are
very important.  Record these numbers for reference when
reporting the problem.

If there is no mail waiting at your account on the POP server, the No New Mail
alert is displayed.  This means that the message you sent yourself in the previous
exercise has not been delivered to your POP account yet.  Click OK.

No new mail alert

Keep selecting Check Mail from the File menu until your test message arrives.
If the message doesn’t arrive in a minute or two, notify your Eudora support
coordinator.
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When mail is found waiting in your POP account, the progress window remains
at the top of your screen, allowing you to monitor the transfer of messages from
the POP server to your PC.  This is followed by the New Mail alert.

New Mail alert

Click OK.  The In mailbox window is displayed with your test message summary
listed inside.

Message listed in In mailbox

Messages are listed in mailbox windows as individual message summaries.  A
message summary is divided into fields containing the status and priority of the
message (these are discussed in the “Reference” chapter), the name or address of
the sender, the time and date the message was sent, its size in K (K = 1024 bytes),
and the contents of its Subject: field.

To select (highlight) the message summary, single-click anywhere on the
summary.  To open the message, double-click on its summary.  Do this for your
arrived test message to display it on your screen.
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Test message display

Incoming messages are stored indefinitely in the In mailbox until they are deleted
or transferred to another mailbox (as described later in this tutorial).

To close the message, either double-click the close box in the upper left hand
corner of the message window or select Close from the File menu.  The In
mailbox can also be closed in the same fashion.

Current Messages

Most Eudora commands can be applied either to an open message window or to
highlighted message summaries in a mailbox window.  This allows Eudora users
to apply commands (such as Transfer, Forward, and Reply) to messages without
opening them first.  Whenever the term current message is used in this tutorial or
in the “Reference” chapter, it refers to a message that is open and is in the
topmost window or whose message summary is highlighted within a mailbox
window.

When a message window is open and front most, it is the current message
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A selected message summary is current

Examples of current messages

Replying To a Message

For any current incoming message (an incoming message is one that someone has
sent to you), you may easily initiate a reply message to its sender without having
to create a new message from scratch.

Open the In mailbox by selecting In from the Mailbox menu.  Single-click on the
message summary of your test message to highlight it.  From the Message menu,
select Reply to initiate a reply to this message.

Note: Select Reply, not Reply To; the Reply To menu item is for use with
the quick recipients list, which is described in the “Reference”
chapter.

A new composition window is displayed, with the sender’s address (in this case,
your own) automatically placed in the To: field of the header.  The original
sender’s text, preceeded by the time and date the original message was sent, is
automatically included in the body of the message (prefixed by “>”  at the
beginning of each line).  This text may be edited as needed.  You may enter more
text in the reply message just as in any outgoing message.  At this time, move the
insertion point to the area below the original message and type in some additional
text.

Replying to a message
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Do not send the reply message at this time.  Instead, save it as described in the
“Saving an Outgoing Message” section.

Saving an Outgoing Message

Sometimes it is convenient to save an outgoing message either as a safeguard
when typing long messages, or for temporary storage so you can return to it at a
later time for changes or additions before sending it.

To save any current outgoing message, such as your new reply message, select
Save from the File menu.  This doesn’t close the composition window but it does
save the version of the message (as it appears at the time of the save) in the Out
mailbox, which holds all outgoing mail.

As long as an outgoing message has not been sent out on the network, you can
make changes to it.  For example, if you want to also send the message to another
person, you can add his/her address to the To: field  (any two addresses in a
single field must be separated by a comma).  Having saved your reply message,
close the reply message window.  Open the Out mailbox (from the Mailbox
menu, select Out) to view the message summary.  Saved messages are identified
by a bullet (●) in the far left column of the message summary.

An outgoing message saved in the Out mailbox

Transferring a Message Between Mailboxes

Eudora helps you to organize your incoming mail by allowing you to create new
mailboxes and easily transfer messages between them.

First, create a new mailbox while simultaneously transferring your test message
into it.  From the Mailbox menu, select In to open the In mailbox.  Single-click
on your test message summary to highlight it (making it the current message).
Then, select New... from the Transfer menu.  The New mailbox dialog is
displayed.
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New mailbox dialog

Any name can be typed in the new mailbox title field, but for this example, type
Testing.  Click OK to create the new mailbox.  Because your test message was
highlighted when you selected New... from the Transfer menu, it is automatically
transferred into the Testing mailbox.  To verify this, select Testing from the
Mailbox menu.

Current messages can also be transferred between existing mailboxes.  To
demonstrate this, move your original test message from the Testing mailbox back
into your In mailbox.  Highlight the test message summary (click on it once in the
Testing mailbox window) and then select In from the Transfer menu.

Message Transfer
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After Transfer

Transferring a message

Deleting a Message

Messages are stored indefinitely in any mailbox until they are explicitly deleted
or transferred to another mailbox.  Outgoing messages that were saved for further
changes remain in the Out mailbox until they are either sent or deleted.  Any
current message can be deleted.

Open your test message from the In mailbox.  Then, select Delete  from the
Message menu.  Next, open the Out mailbox and select (without opening) the
message summary of the reply message you generated previously.  Again, select
Delete from the Message menu to remove the message from the Out mailbox.

As a safeguard, the Delete command doesn’t actually delete messages but
transfers them to the Trash mailbox.  So, if you suddenly realize you mistakenly
deleted a message, it can be recovered from and transferred out of the Trash
mailbox.

All messages stored in the Trash mailbox are automatically deleted when you quit
Eudora.  To manually delete messages held in the Trash mailbox, select Empty
Trash from the Special menu.
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Reference

Introduction

This section provides detailed explanations of all available Eudora functions.

Main Window Icon

The main window icon displays when Eudora’s main window is minimized.  It
provides a unique indication of when new mail has been delivered, when
outgoing messages are queued, or both.

Normal

This is the normal state of the icon.  There is no new mail and no messages are
queued and waiting to be sent.

New Mail

The mailbox is open and has a letter in it, indicating that new mail has been
delivered.

Queued Messages

The flag on the side of the mailbox is in the up position, indicating that you
have outgoing messages queued for delivery.

New Mail/Queued Messages

The mailbox is open and has a letter in it and the flag on the side of the mailbox
is in the up position, indicating that new mail has been delivered and outgoing
messages are queued for delivery.

Main Window Toolbar

The main window tool bar consists of 7 buttons displayed just under the menu
titles.

Main window toolbar

Each button’s function is described in the toolbar tip displayed just below the
button when holding the mouse pointer over the button.
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New Message

Main window toolbar tip

Note: The main window toolbar and toolbar tips can be turned on or off
in the Settings dialog (Fonts & Display).

Trash Button

This button transfers the current message(s) to the Trash mailbox.  Its function
is identical to the Delete command under the Message menu (see the “Deleting a
Message” section).

New Message Button

This button opens an outgoing message composition window.  Its function is
identical to the New Message command under the Message menu (see the
“Creating an Outgoing Message” section).

Reply Button

This button generates a reply to the current message or message summaries.  Its
function is identical to the Reply command under the Message menu (see the
“Replying to a Message” section).

Forward Button

This button generates a forward message for the current message or message
summaries.  Its function is identical to the Forward command under the
Message menu (see the “Forwarding a Message” section).

Redirect Button

This button generates a redirect message for the current message or message
summaries.  Its function is identical to the Redirect command under the
Message menu (see the “Redirecting a Message” section).

Nicknames Button

This button displays the Nicknames window.  Its function is identical to the
Nicknames command under the Window menu (see the “Creating and Using
Nicknames” section).

Print Button

This button prints a current message, signature file, or Ph window.  Its function
is identical to the Print... command under the File menu (see the “Printing”
section).
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Creating an Outgoing Message

An outgoing message is a message you send to someone else.

To create an outgoing message, select New Message from the Message menu.  A
new Outgoing message window entitled No Recipient, No Subject  is displayed
with the blinking insertion point situated at the start of the To: field.  The
composition window consists of the title bar, the icon bar, the message header,
and the message body.

Outgoing message window

Title Bar

The title bar provides information about incoming and outgoing messages,
including the name of the sender (if it is an incoming message) or addressee (if it
is an outgoing message), the time and date the message was delivered or sent, and
a brief message summary.  New messages are labeled No Recipient, No Subject
until they are sent or queued.  Queued message do not have a time stamp until
they are sent.

Icon Bar

The icon bar consists of a series of objects that are displayed just under the title
bar.  It allows you to control your message’s priority, override some of your
preference settings for that message only, and send or queue the message.  There
are three combo boxes and five buttons.  Each of the five buttons may be turned
on or off for the current message by clicking on it.  If there is a shadow around
the button (indicating that the button is depressed) the button is turned on.  The
popup menus and buttons are described below.

The Icon Bar
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Note: The default settings for the icon bar are determined in the Settings
dialog (Sending Mail).

Priority Combo Box
The leftmost object in the icon bar is the Priority combo box.  For most
messages, the priority is (Normal).  If you want to indicate that your message is
of higher or lower priority than a normal message, use this combo box.
Priorities are discussed in the “Message Priorities” section.

Signature Combo Box
The Signature combo box allows you to automatically attach your signature to
the end of each message you send.  Signatures are discussed in the “Creating a
Signature” section.

Attachment Type Combo Box
The Attachment Type combo box allows you to select what format documents
that you attach to outgoing messages are encoded in Multipurpose Internet Mail
Extensions (MIME) or Bin Hex.  MIME is best for recipients with MIME (for
more information on MIME, see Appendix D) and Bin Hex is most compatible
with old Macintosh mailers and previous versions of Eudora.

Quoted-Printable Encoding
If this button is on, quoted-printable encoding may be used when sending
messages that contain long lines of text or special characters.  When on, it is
used for all attachments.  It is recommended that this button always be on.

Text As Document
If this button is on, plain text files attached to messages are incorporated into
the message as part of the message body.

Word Wrap
If this button is on, a carriage return is not required at the end of each line you
type in an outgoing message; Eudora automatically wraps text to the next line,
with line breaks at roughly 76 characters per line.

Tabs in Body
If this button is on, hitting the [tab] key within the message body results in
Eudora inserting enough spaces to move the insertion point to the next tab stop.
This mimics the way tabs work on many terminals.  If this button is not on,
hitting the [tab] key returns the caret to the To: field of the message header.

Keep Copy
If this button is on, a copy of each sent message is kept in the Out mailbox
(their summaries are marked with an “S” in the far left column of the Out
mailbox window, indicating that they have been sent).  These messages are
saved until they are deleted or transferred to a different folder.
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Send or Queue
If the Immediate Send option in the Settings dialog (Sending Mail) is turned on,
the rightmost button in the icon bar is labeled Send.  Clicking the Send button
immediately sends the message.  Otherwise, this button is labeled Queue, and
has the same function as the Queue for Delivery command under the Message
menu (upon clicking this button, the message window closes and the message is
held in the Out mailbox, marked ready for delivery).

Message Header

Outgoing message headers consist of six fields:  To:, From:, Subject:, Cc:, Bcc:,
and Attachments:.  Each field holds a different piece of information.  The To:,
Subject:, Cc:, and Bcc: fields can be directly edited.

To move the insertion point from field to field, press the [tab] key or click in the
desired field with the mouse.  When entering information into the fields, you can
use the standard Windows text-editing tools provided under the Edit menu.  Here
is a brief description of the intended contents of each field:

To:
The intended recipient’s e-mail address, or a nickname you have defined (see the
“Creating and Using Nicknames” section).  Multiple addresses are allowed, but
must be separated by commas.

From:
The sender’s e-mail address.  This is usually your POP account plus your real
name.  You can use a return address other than your POP account by entering the
desired address in the Return Address field of the Settings dialog (Personal
Information).

Subject:
Brief text indicating the contents of the message.  This field can be left blank
(though it is a breach of e-mail etiquette to do so).

Cc:
E-mail address or nickname of person to whom a copy of the message is to be
sent.  Multiple addresses are allowed but must be separated by commas.  This
field may be left blank.

Bcc:
“Blind” carbon copy.  Like addresses listed in the Cc: field, addresses listed here
receive copies of the message.  Unlike addresses listed in the Cc: field, addresses
listed here do not appear in the message header of the recipients.  This is useful
when you want to send a copy of a message to someone without everyone else
knowing you did so.  Multiple addresses are allowed but must be separated by
commas.  This field can be left blank.

Attachments:
List of documents being sent along with the message.  Specify these through the
Attach Document command under the Message menu (see the “Attachments”
section).  To delete an attachment from a message, select it by single-clicking on
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the attachment title and press the [delete] key.  You cannot enter information
directly into this field.  This field can be left blank.

Message Body

After filling in the fields, move the insertion point to the space below the message
header.  Type the body of the message here.  Feel free to use the standard
Windows text-editing tools provided under the Edit menu (see the “Summary of
Menu Commands” section).

If the Word Wrap button on the icon bar is turned on, you don’t need to press
[Enter] at the end of each line of text.  The text wraps to the next line
automatically.  If this option is not set, be sure to type [Enter] at the end of each
line or your message may not be legible on the recipient’s computer.  To use tabs
in the message body, press the Tabs in Body button in the icon bar.

Saving an Outgoing Message for Later Changes

Sometimes it is convenient to save an outgoing message either as a safeguard
when typing long messages, or so you can return to it later to edit or add more
text.

To save the message while the outgoing message window is open, select Save
from the File menu.  The message window does not close, but the current version
of the message is saved in the Out mailbox.  You might notice that the title
appearing at the top of the message window changes from No Recipient, No
Subject to what you typed in the To: and Subject: fields of the message.

If you now close the message (by clicking the close box in the upper left-hand
corner of the message window, or by selecting Close from the File menu), it can
be re-opened from the Out mailbox for further changes.  As with any message
summary listed in a mailbox window, it can be identified by the contents of its
To: and Subject: fields. A bullet (●) in the far left column of a message summary
listed in the Out mailbox indicates that the message is being indefinitely held
there and is queueable.  Such messages remain in the Out mailbox until they are
queued and sent or deleted.



Eudora User Manual Reference

QUALCOMM Incorporated 31

A sendable message saved in the Out mailbox

If you try to close an outgoing message window without specifically saving that
version of the message, an alert is displayed asking if the message should be
saved or the changes discarded.  If you select Discard and the message has never
been saved, the message is deleted.

Closing an unsaved composition window

Sending A Message

One-Step Send

If the Immediate Send option in the Settings dialog  (Sending Mail) is turned on,
select Send Immediately from the Message menu to immediately send a current
message.  Alternatively, the rightmost button appearing in the icon bar at the top



Reference Eudora User Manual

32 QUALCOMM Incorporated

of the current message window is labeled Send.  Click this button to send the
current message.

Clicking the Send button

A progress window is displayed momentarily at the top of the screen indicating
the progress of the transmission.

Two-Step Send

Some people may prefer to compose many messages and transmit them all at
once.  Eudora lets you queue messages in the Out mailbox for delivery at a later
time (this is particularly handy if you are not always connected to your network
when using Eudora).  However, this is only possible if the Immediate Send option
in the Settings dialog (Sending Mail) is turned off.

To accomplish the first step for any outgoing current message,  select Queue For
Delivery from the Message menu.   Alternatively, the rightmost button appearing
in the icon bar at the top of the current message window is labeled Queue.  Click
this button to queue the current message for later delivery.

Clicking the Queue button

Either of these selections closes the message window (if it was open), saves the
message in the Out mailbox and marks it as queued, meaning ready to be
delivered.  Queued messages are marked by a “Q” in the far left column of the
Out mailbox.

A Queued message in the Out mailbox

For the second step, select Send Queued Messages from the File menu.  This
sends the queued message (or messages).  A progress window is displayed
momentarily at the top of the screen indicating the progress of the transmission.
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Timed Messages

It is possible to tell Eudora to send a message at some specific time in the future.
To do this for the current outgoing message, select Change Queueing... from the
Message menu.  The Change Queueing dialog is then displayed.

Change Queueing dialog

If you choose Right Now, the message is sent immediately upon clicking the OK
button.  If you choose Next Time Queued Messages are Sent, the message is sent
the next time queued messages are sent.  If you choose On or After, you can use
the time and date fields to fill in the time when the message should be sent.  The
message is saved in the Out mailbox with a Q in the status column, just as if it
were a normal queued message.  However, the message is not actually sent until
the specified time arrives.

Note: For the message to be sent at the correct time, Eudora must be
running when the message is due to be sent.  If Eudora is not
running, the message is sent the first time Eudora is run after the
selected time has passed.

Sending Queued Messages on Check

If the Send on check option in the Settings dialog (Sending Mail) is turned on,
every time a manual or automatic mail check occurs, all queued messages are
sent, thus saving you the step of selecting Send Queued Messages.

Quitting with Queued Messages

If you quit Eudora after you have queued messages, but without sending them
using Send Queued Messages, Eudora gives you the opportunity to send the
messages before you quit.
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Quitting with queued messages

If you quit with timed messages, and the messages are due to be sent within the
next 12 hours, Eudora warns you and gives you the opportunity to send them.

Quitting with timed messages

Editing a queued message

To edit a queued message, open the Out mailbox and double-click on the desired
message summary to open its composition window.  Make the necessary edits and
re-queue the new version of the message with the Queue For Delivery or Change
Queueing... commands from the Message menu or the Save command from the
File menu.  You can also re-queue the message using the Queue button on the
icon bar.  The message is returned to the Out mailbox with a queued status.  If
you close the changed message without choosing one of these, an alert is
displayed asking you to verify the changes.

Changing the Status of a Queued Message

A message that is queued but as yet unsent may be unqueued using the Change
Queueing... command.  Open the Out mailbox and select the desired message
summary.  Then, select Change Queueing... from the Message menu and click
on Don’t Send.  This changes the message status from queued (Q) to saved (●).
The message is held in the Out mailbox until it is either deleted or re-queued and
sent.

Note: You can also send a message immediately or change it to timed
send using the Change Queueing... command.

Keeping Copies of Outgoing Messages

Once a message is sent, it is put into the Trash mailbox unless the Keep copies of
outgoing mail option in the Settings dialog (Sending Mail) is turned on or the
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Keep Copy button in the icon bar is on.  In these cases,  the message is left in the
Out mailbox and is annotated with an S in the far left column of the Out mailbox
indicating that the message has been sent.

Copies of outgoing messages saved in the Out mailbox

Password Protection

There is password protection on mail checks to your account on the POP server.
Each time the Eudora program is opened, your password is requested prior to the
first mail check, whether it is conducted automatically or manually.  If automatic
checking is set in the Settings dialog (Checking Mail), a dialog requesting your
POP server account password is displayed upon first opening Eudora.  If
automatic checking is disabled, the same dialog is displayed at the time of your
first mail check.

Password dialog

Type in your password and click OK.  If you make a mistake before clicking OK,
simply backspace and re-enter the password correctly.

If your password is rejected, an error message is displayed indicating that you
have entered the wrong password (see below).  Select Check Mail from the File
menu to redisplay the password dialog.



Reference Eudora User Manual

36 QUALCOMM Incorporated

Wrong password

Note: Remember that the Eudora password may be case-sensitive
(depending on your POP server), so it must be typed in exactly or
it is rejected.

As long as it is running, Eudora remembers your password.  If you don’t want it
to remember (when, for example, you are away from your PC), select Forget
Password from the Special menu.  At your next mail check you are prompted for
your password again.

Another password-related option is Save password, which is in the Settings dialog
(Checking Mail).  This option makes Eudora remember your password from one
session to the next (you NEVER have to enter your password again, even if you
quit and restart Eudora).  This option should only be used if your PC is in a
secure location.

Finally, the Change Password... command in the Special menu can be used to
change your POP server password if your POP server machine is running a
compatible password-change server.  You’ll be asked to enter your old password
once, and your new password twice.

Note: For information on password-change servers, see Appendix A of
this manual.

Checking For and Receiving Mail

The POP server is the machine where your mail is received and stored until it is
transferred to the Eudora program on your PC.  Your POP server account is
specified in the POP Account setting in the Settings dialog (Getting Started).

Note: To best understand the functioning of the POP server with respect
to Eudora, please see Appendix C.

There are two methods to check your designated POP server to see if you have
new mail.  One method is automatic and the other is manual.  Both methods
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deliver any mail addressed to you from the POP server to your PC.  Before any
checks are made, however, the POP server requests your account password.

Automatic Checking

Eudora automatically checks for mail if you tell it how often to do so.  From the
Special menu, select Settings....  Then select Checking Mail.  The Checking Mail
settings include an option entitled Check for mail every ? minute(s).  Type in a
value and Eudora automatically checks for mail at the desired interval whenever
it is running (even if you are using other applications on your PC).  For example,
if you type in 15, Eudora checks for mail every 15 minutes.  In fact, 15 minutes is
a good minimum interval, as checking mail more frequently puts an unnecessary
load on your POP server.

Note: If automatic checking is set, the Check Mail command under the
File menu displays the next time that an automatic check is
scheduled to occur.

When Eudora does an automatic check, you can be notified of new mail in one or
all of three different ways: an alert dialog, a special sound, or the opening of the
In mailbox.  These options are turned on or off in the Settings dialog (Getting
Attention).  In addition, if Eudora is minimized when new mail arrives, the
minimize icon also changes when new mail arrives.

Note: For the sound alert to work, you may need a sound driver for the
PC speaker (see “Appendix A” for a source for this driver).

When you receive notice that new mail has arrived, select Eudora from the task
list or press [Alt] + [Tab] to switch to Eudora.  Mail usually arrives in the In
mailbox.  The messages are listed in the order they are received, with the most
recent message listed last.

Unread messages in the In mailbox

If the In mailbox is not already open, select In from the Mailbox menu.  Unread
messages are designated by a bullet (●) in the far left column of the message
summary.  Double-click anywhere on a message summary to open the message.
Incoming messages are saved indefinitely in the In mailbox until they are deleted
or transferred to another mailbox.
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Manual Checking

You may check for mail manually at any time by selecting Check Mail from the
File menu.  If you haven’t successfully entered your password since opening the
Eudora program, you are prompted for it.

A Progress window is displayed momentarily at the top of the screen as the POP
server is checked.

The Progress window during a mail check

If there is a problem reaching the POP server, an error message alert is displayed.
To rectify the problem, review the POP server field in the Settings dialog
(Getting Started) for correctness.  If there is no obvious error, contact your
company’s Eudora support coordinator.

Error while checking mail

Note: If you ever have a problem of this type, the numbers in the ()’s are
very important.  Record these numbers for reference when
reporting the problem.

If there is no mail waiting at your account on the POP server, the No New Mail
alert is displayed.  Click OK.  You may check for mail again later.
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No New Mail alert

If there is new mail, it is transferred automatically from the POP server to Eudora
on your PC.  A progress window is displayed at the top of your screen allowing
you to monitor the mail transfer.  If the Use an alert dialog box option in the
Settings dialog (Getting Attention) is turned on, the New Mail alert is displayed,
stating that new messages have been delivered.

New Mail alert

Depending on your settings, the In mailbox window may display.  Mail arrives in
the In mailbox.  Unread messages in the In mailbox are designated by a bullet (●)
in the far left column of the message summary.  Double-click anywhere on a
message summary to open the message.  Incoming messages are saved
indefinitely in the In mailbox until they are deleted or transferred to another
mailbox.

Leave Mail on Server Option

During a mail check, Eudora normally transfers your incoming messages from
your account on the POP server to your PC, and deletes them from the POP
server.  This may prove awkward for people who sometimes want to read mail
from a secondary PC.  It results in non-consolidated storage of messages – if you
read mail through a secondary PC, you wouldn’t be able to act on that mail from
your primary PC.

The Leave mail on server option in the Settings dialog (Checking Mail) solves
this dilemma.  If this option is turned on, Eudora transfers all of your new
messages from the POP server to the PC you are presently using (presumably a
secondary PC), while keeping copies of those messages in your account on the
POP server. On the next mail check from the secondary PC, Eudora ignores the
copies of previously read messages and looks for new ones.
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When using your primary PC, you would then turn the Leave mail on server
option off, so that all messages (new ones as well as copies of old ones you read
through other PC systems) are transferred to and consolidated on the one primary
system.  The Leave mail on server option should be used with care, since it can
result in a buildup of messages on the POP server machine.

Skip big messages Option

If the Skip big messages option in the Settings dialog (Checking Mail) is turned
on, Eudora does not download messages that exceed 40k bytes.  Instead, it
downloads only the first few lines of such messages and adds a note at the bottom
stating that the whole message has not been transferred.  This can be useful on
slow connections.  To download the complete message, turn off the Skip big
messages option in the Settings dialog (Checking Mail) and check mail again.

Stopping a Mail Check

If you want to stop a mail check in the middle (because it is taking longer than
anticipated), click the Stop button in the progress window or press the [Esc] key.

Creating a Mailbox

To create a new mailbox, select New... from the Mailbox menu.  The New
Mailbox Dialog is displayed.

New mailbox dialog

Type in the new mailbox name and click OK. The mailbox is created and added
to the Mailbox and Transfer menus.

You can also create mailboxes using the Mailboxes window under the Windows
menu (see the “Mailboxes Window” section).  The Mailboxes window is most
useful if you want to create several mailboxes at one time.

Creating a Mail Folder

Eudora allows you to create mail folders in which you may keep one or more
mailboxes and even other subfolders that hold additional mailboxes.  In other
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words, not only can mailboxes be organized into folders, but folders can be
contained one within another.

To create a new mail folder, select New... from the Mailbox menu.  The New
Mailbox Dialog is displayed. Type the name of the new mail folder and check the
Make it a Folder option.  Click OK to create the folder.

Creating a mail folder

The new folder name is displayed at the bottom of the list of mailbox names
under the Mailbox and Transfer menus.  There is an arrow next to the name
designating it as a folder and not as a mailbox.  You cannot transfer messages into
this folder, however, since messages must be in mailboxes and you have not yet
created a mailbox within the folder.  Therefore, the New Mailbox Dialog is
displayed again.  Now, type the name of the mailbox you want to create within
the newly-created folder and click OK.

Creating a Mailbox Within a Folder

To create a new mailbox within a particular folder, select that folder from under
the Mailbox menu and choose New... from the submenu that is displayed. The
New Mailbox Dialog is displayed.  Type in the new mailbox name and click OK.
The mailbox is created and added to the Mailbox and Transfer menus.  You can
also create subfolders in the same manner.  Just check the Make it a Folder
option.

Opening a Mailbox

To open a mailbox, select the desired mailbox from the list of mailboxes under
the Mailbox menu.  The mailbox window is then displayed.

To open a “nested” mailbox (one that is contained within a mail folder), select the
outermost folder from the Mailbox menu (folders are designated by an arrow
next to their names).  This displays the submenu of mailboxes and/or folders
within the outer folder.  Select the desired mailbox (or continue selecting
subfolders until the mailbox can be selected).



Reference Eudora User Manual

42 QUALCOMM Incorporated

If any messages are stored in the mailbox, they are listed as individual message
summaries.  Each message summary is divided into six columns: Status (S),
Priority (P), Sender (Who), Date, Size (K), and Subject.  See the “Anatomy of a
Mailbox Window” section for descriptions of these columns.

Anatomy of a Mailbox Window

 Mailbox windows consist of a title bar and list of message summaries.

The mailbox window

Title Bar

The title bar provides the mailbox name.

Message Summaries

Each line in a mailbox window represents one message and is called a message
summary.  To select a message summary, single-click on it.  There are several
ways to select more than one summary.  You can select a summary and drag
through the ones you want to select.  You can select one summary, hold down the
[Shift] key, and select another summary to select both summaries and all the
summaries between them.  Finally, you can hold down the [Ctrl] key and select
individual summaries.  This allows you to make “disjoint” selections.

Disjoint selections in a mailbox window
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Message Summary Columns
Each message summary is divided into six columns:  Status (S), Priority (P),
Sender/Recipient (Who), Date, Size (K), and Subject.

The Status column displays the message status, which is one of the following:

● The message has not been read (all mailboxes except Out), or is
queueable but has not been queued (Out mailbox only).

<blank> The message has been read (all mailboxes except Out), or is not
yet able to be queued because it has no recipients (Out mailbox
only).

R Reply has been chosen for the message.

F Forward has been chosen for the message.

D Redirect has been chosen for the message.

S The message has been sent (outgoing messages only).

- The message was transferred from the Out mailbox before being
sent.

The Priority column displays the message priority, which is one of the following:

Highest priority.

High priority.

<blank> Normal priority.

Low priority.

Lowest priority.

For more information on message priorities, see the “Message Priorities” section.

The Sender/Recipient column shows the sender of the message (for incoming
messages) or the recipient or intended recipient (for outgoing messages).

Note: Bugs in some POP servers/mail transport systems cause Eudora to
display the sender of incoming messages as ???@???.  This is
because the required From: header is missing.

The Date column displays the date and time the message was sent, or, for timed
messages, the date and time the message is scheduled to be sent.

The Size column displays the size of the message in K (K = 1024 bytes).

The Subject column displays the subject of the message.  The sender originally
typed this information into the message header, but it can be modified by you (see
the “Editing Message Subjects” section).
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Incoming Message Window

To open a message, double-click on its message summary, or, if the message
summary is current (highlighted), press the [Enter] key.  The incoming message
window is then displayed.

Incoming message window example

The incoming message window consists of the title bar, the icon bar, and the
message body.

Title Bar

The title bar provides information about the message, including the name of the
sender, the time and date the message was delivered, and the message subject.

Icon Bar

The icon bar consists of a series of objects that are displayed just under the title
bar.  These include the priority popup and the Subject field.

Priority Popup
For most messages, this is just an empty box (normal priority).  If you want to
indicate that this message is of higher or lower priority than a normal message,
use this popup.  Priorities are discussed in the “Message Priorities” section.

Subject:
This is the message subject that was assigned by the sender.  It can be edited
directly on the icon bar (see the “Editing Message Subjects” section).

Message Body

The message body contains the message header and text information, as well as
descriptions of any attachments.  Attachments can be opened from within the
message window by double-clicking on the attachment title (see the
“Automatically Opening Attachments” section).
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Deleting a Message

As a safeguard against inadvertent deletions, two steps are required to delete a
message in Eudora.  For any current message, choose Delete from the Message
menu.  This does not actually delete the message, but transfers it to the Trash
mailbox.  To delete messages from the Trash mailbox, select Empty Trash from
the Special menu.  Quitting the program also empties the contents of the Trash
mailbox when the Empty Trash when exiting option in the Settings dialog
(Miscellaneous) is turned on.  Finally, if you want to delete just a few messages
from the Trash mailbox, highlight them and select Delete from the Message menu
or hit the Trash Button on the toolbar.  Deleting a message that’s already in the
Trash removes it from Eudora completely.

Also, if the Require confirmation for deletes option in the Settings dialog
(Miscellaneous) is turned on, any attempt to delete a message that you have never
opened (or a Queued message that hasn’t been sent) results in Eudora asking for
confirmation before proceeding with the deletion.

Warning for deleting unread or unsent messages

Compacting Mailboxes: Recovering Storage Space

Even after a message has been deleted with the two-step process described above,
the storage space which that message originally required is still taken.  Normally,
Eudora recovers this space automatically when it becomes troublesome.
However, if disk space is very tight, you can force this to happen earlier than
usual.  In order to reclaim the wasted storage space in all mailboxes, select the
Compact Mailboxes from the Special menu.

Mailboxes can also be compacted individually using the Mailbox Size button in
the the lower left corner of the mailbox window.  To force Eudora to recover
wasted space for a current mailbox, click on this button.

Note: Eudora compacts mailboxes automatically when you close them
under either of two conditions.  Mailboxes are compacted if the
amount of wasted space in the mailbox is greater than the amount
of space the messages in the mailbox use, or if the amount of space
wasted in the mailbox is greater than 5% of the free space on the
drive that contains it.
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Transferring a Message to a Different Mailbox

Messages may be transferred between any two mailboxes.  For any current
message, select the mailbox to which the message should be transferred from the
Transfer menu.  The message is transferred from its previous location to the
selected mailbox.

Transferring a message

If you hold down the [Shift] key while transferring a message, the message is
copied into the new mailbox instead of transferred.  This is useful if you want to
file a message in more than one mailbox.

Creating a Mailbox During Transfer

To create a mailbox and transfer the current message into it at the same time,
select New... from the Transfer menu instead of the name of a mailbox.  The
New Mailbox Dialog is displayed.

New mailbox dialog

Type in the new mailbox name and click OK.  The mailbox is created and added
to the Mailbox and Transfer menus.  The current message is also transferred into
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the new mailbox.  However, if you check the Don’t transfer, just create mailbox
option, the mailbox is created but the message isn’t transferred into it.

You can also create mailboxes using the Mailboxes dialog under the Window
menu (see the “Mailboxes Window” section) or using the Mailbox menu (see the
“Creating a New Mailbox” section).  The Mailboxes window is most useful if you
want to create several mailboxes at one time.

Creating a Mailbox Folder During Transfer

Eudora allows you to create mail folders in which you may keep one or more
mailboxes and even other subfolders that hold additional mailboxes.  In other
words, not only can mailboxes be organized into folders, but folders can be
contained one within another.

To create a new mail folder during message transfer, select New... from the
Transfer menu instead of the name of a mailbox.  The new mailbox dialog is
displayed.  Type the name of the new mail folder and check the Make it a Folder
option.  Click OK to create the folder.

Creating a mail folder

Your message can’t be transferred, however, since messages must be in
mailboxes and you have not yet created a mailbox.  Therefore, the new mailbox
dialog is displayed again.  Now, type the name of the mailbox you want to create
within the newly-created folder and click OK to complete the transfer.

The new folder name is displayed at the bottom of the list of mailbox names
under the Mailbox and Transfer menus.  There is an arrow next to the name
designating it as a folder and not as a mailbox.

Mailboxes Window

Mailboxes and mail folders provide a structured way for Eudora users to organize
received messages.  The Mailboxes window allows you to create new mailboxes
and folders and to remove and rename them.  You may also want to move
mailboxes and folders from one folder to another one.
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To accomplish any of these tasks, choose Mailboxes from the Window menu.
The Mailboxes window is displayed.

The Mailboxes window

The window has two identical listings with scroll bars.  These list the names of
the mailboxes and folders you have created (folders are identified by a folder icon
to the left of the folder name).  This list is similar to that displayed under the
Mailbox and Transfer menus, except that the In, Out, and Trash mailboxes aren’t
included.  Underneath each of the lists are buttons labeled Rename, New, and
Remove.  Between the lists are two additional buttons labeled Move, each
pointing from one list to the other.

Double-clicking on any of the mailboxes in a list opens that mailbox window on
the screen.  Individual messages can be selected, opened, and otherwise
manipulated from there.

Finding the Mailbox or Folder

If the Mailbox window isn’t big enough to display all of your created mailboxes
and folders, use the scroll bar on the right side of either list to view the rest of the
mailboxes and folders.

Double-clicking on a folder (denoted with an icon of a folder to the left of its
name) changes the current title of the list from Eudora to that of the chosen
folder.  The contents of the list also change to the names of mailboxes and
subfolders contained in the chosen folder.
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Opening a mail folder

To move back out of the subfolder to the folder that contains it, select the folder
from the list title popup.

Moving back out of a mail folder

Removing a Mailbox or Folder

With the Mailboxes window open, use the scroll bar and selection tool to locate
the name of the mailbox or folder that you want to remove.
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Note: You can perform this function using either of the two lists in the
Mailboxes window.  It is not necessary to locate a mailbox or
folder in both lists before deleting it.

Once the desired mailbox/folder is found, click on it once to select it.  Then, click
on the Remove button that is located below the list.

Starting to remove a mailbox

If the mailbox has any messages in it, a dialog is displayed asking you to confirm
the mailbox removal.  Click on the Remove It button to remove the mailbox.

Mailbox removal dialog

If you press the [Ctrl] key while selecting from a list of mailboxes/folders, you
can select more than one mailbox or folder simultaneously.  When you click on
the Remove button, the mailbox removal dialog is displayed to verify the
removal.  The dialog contains the name of the first mailbox you have selected.  If
you click on Remove it, Eudora removes that mailbox, and then displays another
dialog for the next mailbox.  If you click on Remove all, all of the selected items
are removed without any further prompts.

Note: If you remove a mailbox in which messages are stored, or a folder
in which other mailboxes or folders are stored, all
messages/mailboxes/folders contained within the selected mailbox
are also removed.
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Renaming a Mailbox or Folder

With the Mailboxes window open, use the scroll bar and mouse pointer to locate
the name of the mailbox/folder that you want to rename.

Note: You can perform this function using either of the two lists in the
Mailboxes window.  It is not necessary to locate a mailbox or
folder in both lists before renaming it.

Once the desired mailbox/folder is found, click on it once to select it.  Then, click
on the Rename button that is located below the list.

A dialog is then displayed requesting the new name.  Type in the new name and
click on Rename to rename the mailbox/folder.

Renaming a mailbox or folder

Creating a New Mailbox or Folder

New mailboxes and folders can be created using the Transfer menu, as described
in the “Creating Mailboxes During Transfers” section, or they can be created
using the Mailboxes window.

With the Mailboxes window open, double-click on the folder in which the new
mailbox/folder is to be created to open it.  Its name is displayed above the list,
and its contents are displayed therein.

Note: You can perform this function using either of the two lists in the
Mailboxes window.  It is not necessary to locate a folder in both
lists before creating a new mailbox or folder inside it.

Click on the New button that is located below the list.  A dialog is displayed
requesting the name of the new mailbox.
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Naming a new mailbox

Type in the new name, check the Make it a Folder option if you want to do so,
and click OK.  The new mailbox/folder is displayed in the designated folder’s
listing.  The newly created mailbox/folder is also added to the Mailbox and
Transfer menus.

Moving a Mailbox from one Folder to Another

The Mailboxes window provides the only means for moving mailboxes to other
folder locations.  This is why there are two lists in the window.

To begin, locate in one of the lists the mailbox you want to move.  In the other
list, find and open (by double-clicking on the name) the destination folder so that
its name is displayed above the list and its contents are displayed.  Then, select
the mailbox you want to move.   Click on the Move button that points from the
list containing the item you want to move to the list displaying the destination
folder.  The chosen mailbox is moved to its new location.
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Moving a mailbox, before and after

Attachments

Any file can be attached to and sent with a Eudora message.  To attach a file to a
current outgoing message, select Attach File from the Message menu.  The
Attach file dialog is displayed.  Once the desired file is located, select it and click
on the OK button to attach the file to the message.
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Attaching a document

The attached file functions like a “rider” to the e-mail message, and thus it does
not appear within the message text.  Instead, the full path name of the file is
displayed automatically in the Attachments: field of the message header.

An outgoing message with an attached file

Note: A file cannot be attached to a message through manual editing of
the Attachments: field.

When the message is sent, the attached file is formatted according to the selection
in the Attachment Type combo box in the message icon bar (see the “Icon Bar”
section).

If the chosen file is a plain text file (and if the Put text attachments in body of
message option in the Settings dialog [Attachments] is turned on, or the Text as
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Document button in the icon bar is off), it is not encoded in any special format
before being sent.  Instead, it is added to your message as though you had typed it
in manually.

Multiple Attachments

Multiple files may be sent with a single message, but each file to be attached must
be selected as described above.

Detaching a File

To detach a file before the message is sent out, click anywhere on the name of the
file in the Attachments: field of the composition window.  This selects the entire
attachment name.  Then, press the [Delete] or [Backspace] key or select Clear
from the Edit menu.

Receiving an Attachment

Attachments you receive are automatically decoded and placed in your Eudora
directory unless you specify an attachment directory in the Settings dialog
(Attachments).  To do so, select Settings... from the Special menu and then select
the Attachments settings.

The Attachments settings

Click on the Attachment Directory button to display the Select a directory dialog.
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Selecting an attachments directory

Double-click on the name of a directory to select it (its name should be displayed
above the list). Then, click the Use Directory button.

The dialog then closes.  The name of the directory you just selected is now
displayed on the Attachment Directory button.  If you ever want to specify a
different directory to receive attachments, simply click on this button and the
dialog for choosing an attachments directory is redisplayed.

Attachments are decoded automatically and saved directly into the selected
directory .  The name given your attachments is recorded in the message with
which they came.  If you receive multiple attachments with the same name, a
number is appended to the end of each attachment’s name.

Non-Eudora Users Receiving Attachments

If you send an attachment to someone who doesn’t use Eudora, the attached file is
included at the end of the message in either MIME or Bin Hex format, depending
on how you choose to send it.  It is not usable until the recipient has decoded it
using an appropriate decoding application.
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Replying to, Forwarding, or Redirecting an Incoming Message

This section describes the Reply, Forward, and Redirect commands found in the
Message menu.  These commands are different from the Reply To, Forward To,
and Redirect To commands found in the same menu.  This latter set of commands
is used with the Quick Recipient list (see the Using the Quick Recipient List
section for descriptions of these commands).

Replying to a Message

To reply to a current message, select Reply from the Message menu.  A new
message window is displayed, with the original sender’s address automatically
placed in the To: field of the header.  The original sender’s text is also
automatically included at the beginning of the reply message (prefixed by “>”  at
the beginning of each line).  This text may be edited or deleted as needed.
Additional text may be entered into the reply just as in any outgoing message.
The reply can then be saved for further changes, or simply sent.

A message and its reply



Reference Eudora User Manual

58 QUALCOMM Incorporated

An incoming message for which the Reply command has been used is identified
by an “R” in its message summary.

‘R’ indicates that the message has been replied to

Modified Forms of Reply

There are several variations of the Reply command.

Reply to all
If you hold down the [Shift] key when selecting Reply from the Message menu,
the reply message is sent to the sender of the original message and to everyone
who received it.  This is useful for carrying on group discussions electronically.
If the Reply to all by default option in the Settings dialog (Replying) is turned on,
Reply to all is the default, and you must hold down the [Shift] key to reply only
to the message sender.

When replying to all:
Include yourself
If the Include yourself option in the Settings dialog (Replying) is turned on when
you do a Reply to all, your address is left in the address list of the new message
and you receive a copy of your own reply.  If this option is turned off, Eudora
does not include your return address in the reply to all message.

Note: To determine who you are, Eudora uses the “me” nickname, if you
create one for yourself.  If not, Eudora uses the contents of the
POP Account and Return Address fields from the Settings dialog.

Cc: original To: recipients
If the Put original To: recipients in Cc: field option in the Settings dialog
(Replying) is turned on, the addresses of the original message recipients are
moved from the To: field to the Cc: field of the Reply to all message.  Only the
address of the original sender is placed in the To: field.

Forwarding a Message

You may want to relay, or forward, messages to other users.  To do this, select
Forward from the Message menu for any current received message.  This
transfers the header and body of the received message, denoted with “>” markers
at the beginning of each line, to the body of a new message window.  There, you
must fill in the empty To: field in the message header with the address of the
person to whom you want the message forwarded.  The existing text may be
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edited, and more text may be added to the message.  A forwarded message is
identified (in the From: field) as coming from you.

Forwarding a message

An incoming message for which the Forward command has been used is
identified by an “F” in its message summary.
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‘F’ indicates that the message has been forwarded

Redirecting a Message

Eudora provides a way to redirect messages that you decide were more
appropriately sent to someone besides yourself.  To do this select Redirect from
the Message menu for any current incoming message.  A new message window is
displayed, and you should type in the appropriate recipient in the To: field of the
header.   The address in the From: field is that of the person who originally sent
the message, by way of your address.  In addition, there are no “>” markers at the
beginning of each line of the original text.  However, you may edit or add more
text to the message.

Redirecting a message

An incoming message for which the Redirect command has been used is
identified by a “D” in its message summary.
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‘D’ indicates that the message has been redirected

Redirect and Signatures
When you use Redirect, your signature file (described in the “Creating a
Signature” section) is not added to the message when it is sent, unless the
message was originally created by you.  Eudora considers the message to be
originally from you if the address in the From: field exactly matches your return
address setting (or, if you have not entered a return address in the Settings dialog
(Personal Information), your POP account setting).

Easy Repeat (“Canned”) Messages Using Redirect
If you find yourself sending the same message over and over again to different
people, you can keep a “canned” copy of that message and send it easily using the
Redirect command.  To do this, first compose a new message as you normally
would, but leave the To: field blank.  Save the message, and, if desired, use the
Transfer menu to move it from the Out mailbox into another mailbox (named
“Canned Messages,” perhaps).  When you want to send the message to someone,
locate the message and open it (or simply highlight it in the mailbox window),
select Redirect from the Messages menu, fill in the To: field, and send the
message.
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Creating and Using Nicknames

When addressing messages, Eudora supports the use of nicknames in place of full
user names.  A nickname (sometimes called an alias) is an easily remembered,
shorter substitute for an actual e-mail address or group of addresses.  Typically,
nicknames are created for persons with whom one has repeated correspondence,
and hence serve as a typing and reference shortcut.  Eudora allows nicknames to
be used in place of proper e-mail addresses in the To:, Cc:, and Bcc: fields in the
headers of outgoing messages.

To create, edit, or remove a nickname, select Nicknames from the Window
menu.  The Nicknames window is then displayed.  This window is divided into
three main fields.  The Nickname: field lists all your nicknames; the Address(es):
field displays a selected nickname’s expansion (the addresses that the nickname
represents); and the Notes: field contains your private notes on a nickname.

The Nicknames window

Adding New Nicknames

To add a new nickname, click on the New button.  The new nickname dialog is
displayed prompting you for the name of the new nickname.
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New nickname dialog

Type the name of the new nickname.  If you want this nickname to show up on
the Quick Recipient list under the Message menu (see the “Using the Quick
Recipient List” section), click on the Put it on the recipient list option.  Then,
click OK.

The new nickname is displayed in the Nicknames: field of the Nicknames
window, and the insertion point is placed in the Address(es): field.  Type the
complete e-mail address of the person to be represented by the nickname.

Entering an address for a nickname

If you’d like to add someone’s proper name to the address that you specify, just
put it in parentheses after the e-mail address.

Note: Be aware that the proper name is put in the To: field of mail
messages along with the full address.

You may also type a series of many e-mail addresses (and even other nicknames),
separated by commas or returns ([Enter]), in the Address(es) section.  These
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multiple addresses are represented by the single entered nickname.  In this way, a
nickname can be used for a group mailing list.

Using a nickname as a mailing list

Note: The Nicknames window is the only place where it is permissible to
use the [Enter] key to separate addresses.  Everywhere else, you
must use commas.

The Notes: field can be used to enter any text you’d like to associate with a
nickname, such as the addressee’s company, title, or phone number.

Entering notes for a nickname

Note: The contents of the Notes field is not put in mail you send.
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One nickname can point to another nickname, which can point to still another,
and so on; eventually, however, the nickname must end in a real address or group
of addresses.  For example, Eudora contains John in its expansion, and John is
itself a nickname for jnorth@mist.com.

One nickname using another nickname

Once you’ve finished typing addresses and notes, you can click the New button
again to make another nickname.

When finished making additions or changes, select Save from the File menu to
save the changes.  If you close the Nicknames window without saving the
changes, a dialog is displayed asking whether the additions/changes you just
made should be saved or discarded.

Saving changes to Nicknames
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Changing and Removing Nicknames

To change a nickname, select Nicknames from the Window menu.  Click once
on the desired nickname in the Nickname: field to select it.  Then, click the
Rename button.  A dialog is displayed allowing you to change the nickname.
You may also add or remove the nickname from the Quick Recipient using the
Put it on the recipient list option.  Once the changes are completed, click OK.

Renaming a nickname

To change a nickname’s corresponding e-mail address(es) and notes,  click once
on the desired nickname to select it.  The addresses and notes associated with the
nickname are displayed in the Address(es): and Notes: fields, and may be directly
edited.

To remove the nickname,  click once on the desired nickname to select it.  Click
the Remove button.

When finished editing or making deletions, select Save from the File menu to
save the changes.  If you close the Nicknames window without saving the
changes, a dialog is displayed asking whether the changes/deletions you just made
should be saved or discarded.

Make Nickname Command

The Make Nickname command can be used to make a nickname in two different
ways.

From the Nicknames window itself, use [Ctrl]+ click to select several different
nicknames, and then choose Make Nickname... from the Special menu.  The
new nickname dialog is displayed prompting you for the name of the new
nickname.  Once you have entered the name, click OK to create the new
nickname with the selected nicknames in the Nicknames window as its
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addressees.  This is an easy way to make a group nickname out of existing
nicknames.

Using Make Nickname... in the Nicknames window

Alternately, you can make a nickname out of the address list of a current
message.  Open a mailbox and single-click on the desired message to make it
current.  Select Make Nickname... from the Special menu.  The new nickname
dialog is displayed prompting you for the name of the new nickname.  Once you
have entered the name, click OK.  If multiple messages are current (i.e., you have
several message summaries selected in a mailbox window), addresses are taken
from each message and all are put in the new nickname’s expansion.

Using Make Nickname... with current messages

Note: When an incoming message is current, Make Nickname... pretends
to do a Reply to the current message, and then takes all the
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recipients from the reply message and uses them in the nickname
expansion.  This means that Make Nickname... acts just like Reply
in regard to the Reply to all and Include yourself options in the
Settings dialog (Replying).  That is, if the Reply to all option is
turned on (or you hold down the [shift] key), the nickname is made
for all of the recipients of the messages plus the sender, not just the
sender.  Similarly, if the Include yourself option is turned off, your
address is not included in the new nickname’s expansion.

Using the Nicknames Window to Address Mail

The To:, Cc:, and Bcc: buttons in the Nicknames window can be used to start
mail messages or to add addressees to existing current messages.  To create a new
message from the Nicknames window, select the nickname to which you want to
address the mail (you can select multiple nicknames by holding down the [Ctrl]
key and clicking on each nickname).  Then, click the To: button.

Starting a new message from the Nicknames window

A new composition window is displayed with the selected nickname(s) inserted in
the To: field.  Use the To:, Cc:, and Bcc: buttons to insert additional nicknames
into the corresponding fields.

Note: If you hold down the [Shift] key when addressing messages using
the Nicknames window To:, Cc:, and Bcc: buttons, the full
nickname expansion is inserted into the appropriate message field
rather than just the nickname.

The Nicknames window can also be used to address existing messages, or new
messages created by selecting New from the Message menu.  Make sure the
desired message is current (topmost), then open the Nicknames window and use
the To:, Cc: and Bcc: buttons to address the message.
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Nicknames and the Quick Recipient List

Nicknames and the Quick Recipient list are two separate entities.  Nicknames are
used as an abbreviation for an address or a list of addresses.  The Quick Recipient
list is used to add addresses to messages via the Message menu.  Nicknames do
not need to be on the Quick Recipient list, and not everything on the Quick
Recipient list needs to be a nickname.

However, you may have nicknames to which you often send mail, and it makes
sense to add these nicknames to the Quick Recipient list.  This is easily done from
the Nicknames window.  Examine the Nickname field of the Nicknames window.
Notice that there is a margin between the first letter of each nickname and the
edge of the field.  Now, select a nickname and place the mouse over the margin
between the nickname and the edge of the field.  The cursor changes into a
miniature image of a menu.

Putting a nickname on the Quick Recipient list

Click the mouse once and a bullet (●) is displayed in the margin area.  This bullet
indicates that the nickname has been added to the Quick Recipient list.
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The nickname is on the Quick Recipient list

Click again, and the bullet disappears, removing the nickname from the Quick
Recipient list.

The Quick Recipient list is discussed further in the “Using the Quick Recipient
List” section.  If you rename or remove a nickname that is also on the Quick
Recipient list, the name on the Quick Recipient list is also changed or removed.

Finish Nickname Command

The Finish Nickname command under the Edit menu is another nickname-related
function designed to save typing in header fields.  It allows you to type only a
portion of a nickname in the To:, Cc:, or Bcc: fields of a message, with Eudora
completing the typing task.

To use this option, type only the number of characters in the nickname that make
it unique with respect to other nicknames in the appropriate field of the message
header.  Then, select Finish Nickname from the Edit menu.  The partial text of
the nickname is automatically completed in the header field.

For example, if you type an “S” in the To: field and you only have one nickname
that starts with the letter S, the Finish Nickname function completes the nickname
in the message header.  However, if you have multiple nicknames that begin with
the same letter(s), the Finish Nickname command only completes the nickname to
the last common character.  You must then type in the distinguishing characters.

Note: If you hold down the [Shift] key while finishing a nickname, the
nickname’s expansion is inserted instead of the nickname itself.

Quick Recipient List

It may be more convenient to address a message by selecting a nickname or full
address from a predetermined Quick Recipient list.  This eliminates the need to
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type frequently used nicknames or addresses in the fields of outgoing message
headers.  By selecting (with the mouse) a nickname or address from the Quick
Recipient list,  the address or nickname is automatically entered in the desired
field.  The list may also be used to more easily reply to, forward or redirect
messages.

Eudora uses a single Quick Recipient list that can be accessed via the New
Message To, Reply To, Forward To, and Redirect To selections under the
Message menu, the Insert Recipient selection under the Edit menu, and the
Remove Recipient selection under the Special menu.

The Quick Recipient list

Creating the Quick Recipient List

The Quick Recipient list should consist of the nicknames or e-mail addresses of
common correspondents.

Adding a Nickname to the Quick Recipient List
To add a nickname to this list, select Nicknames from the Special menu.  The
Nicknames window is then displayed.

Notice that there is a margin between the first letter of each nickname and the
edge of the field.  Now, select a nickname and place the mouse over the margin
between the nickname and the edge of the field.  The cursor changes into a
miniature image of a menu.
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Putting a nickname on the Quick Recipient list

Click the mouse once and a bullet (●) is displayed in the margin area.  This bullet
indicates that the nickname has been added to the Quick Recipient list.

The nickname is on the Quick Recipient list

Click again, and the bullet disappears, removing the nickname from the Quick
Recipient list.

Adding an E-mail Address to the Quick Recipient List
To add a full e-mail address to the Quick Recipient list, select any text that makes
up a full address then select Add As Recipient from the Special menu.
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Adding an address to the Quick Recipient list

Using the Quick Recipient List

The Quick Recipient list is displayed when you select New Message To, Reply
To, Forward To, or Redirect To from the Message menu.  To utilize the list,
select a recipient using one of these commands.  Releasing the mouse button
performs the action (new message, reply, forward, redirect) and the chosen
recipient is automatically inserted in the To: field of the new message header.

More than one nickname or address from the Quick Recipient list can be added to
the To:, Cc: and Bcc: fields of any message.  To do this, first place the blinking
insertion point in the field where you want the nickname/address to be inserted.
Then, select the desired recipient from the Insert Recipient list under the Edit
menu.  The chosen nickname/address is placed at the insertion point and a comma
is added (if necessary) to separate the new address from the ones previously
placed in the field.

Removing a Quick Recipient From the List

To remove a nickname/address entry from the Quick Recipient list, select it using
the Remove Recipient option under the Special menu.  When you release the
mouse button, the selected recipient is deleted.

Note: Removing a nickname from the Quick Recipient list does not delete
it from the Nicknames window, but removing a nickname from the
Nicknames window deletes it from the Quick Recipient list.

Finding Text Within Messages

Eudora incorporates a Find function that searches for specific text within a single
message, multiple messages, or even multiple mailboxes.  To display the Find
submenu of commands, select Find from the Edit menu.
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The Find submenu

Finding Text Within One Message

To search for text within a single message, open the message and make sure it is
current.  Then, select Find from the Edit menu and select the Find command
from the submenu.  The Find dialog is displayed, with the blinking insertion point
located in the text field.

The Find dialog

Type the text you want to find in the text field.  When finished entering the
desired text, click the Find button.

Finding text
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Starting at the beginning of the open message, Eudora searches the current
message for the specified text.  If no match is found, the not found alert is
displayed.

Unsuccessful search

If the search is successful, the message is scrolled to the first point where the
match is found and the matching text is highlighted.

Successful search

To continue searching in the same message for the next occurrence of the text,
click the Find button in the Find dialog, or select the Find Again command from
the Find submenu.  These commands are equivalent and limit the search to the
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same message.  Repeating these commands cycles through the matches in the
open message only.

Finding Text Among Multiple Messages and Mailboxes

The Next, Next Message, and Next Mailbox commands are located in the Find
submenu (under the Edit menu) or as buttons in the Find dialog.

The Find dialog

Next
The Next button (or Next command) allows you to search for the next match of
the specified text until it is found either in the same message or among all
messages in the current mailbox.

Note: The Next command initiated in an open mailbox (even with
message[s] selected) searches for the specified text among all
messages contained in that mailbox.  The search begins with the
first message in the mailbox.

Next Message
The Next Message button (or Next Message command) begins the search at the
message after the current message.  Eudora continues to search until it finds a
matching character string, even if it has to open more than one message or a new
mailbox.

Next Mailbox
The Next Mailbox button (or Next Mailbox command) begins the search for the
specified text in the mailbox following the current mailbox.  The search is
conducted among all messages in that mailbox and any subsequent mailboxes,
including the In, Out, and Trash mailboxes.

Note: Mailboxes are searched in the order they are listed under the
Mailbox menu until the current mailbox is reached.

Match Case

Normally, Eudora ignores capitalization when searching.  If you want Eudora to
consider capitalization when searching, check the Match Case option in the Find
dialog.  When this option is checked, Eudora searches for exact matches of
character strings, including any capitalization.

Summaries Only

If you know the text you are searching for is included in a message summary,
check the Summaries Only option in the Find dialog.  When you click the Find
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button, Eudora searches for the text only in the Sender and Subject fields of
message summaries as they appear in mailbox windows.  Eudora searches much
faster when this option is checked.

Enter Selection Command

If you don’t want to actually type the text in the Find dialog (for example, the text
is very long or complex), highlight it in an existing message, and then select
Enter Selection from the Find submenu.  This automatically inserts the selected
text at the insertion point in the Find dialog.  Then, select the Find command
from the Find submenu to start the search.

Stopping a Find

If you want to stop Eudora from continuing a search, click the Stop button on the
progress window or press the [Esc] key.

Sorting Messages Within Mailboxes

It is possible to sort the message summaries in a mailbox window according to
the contents of any of the message summary columns.  To do this,  first open the
mailbox to be sorted, then select the appropriate command from the Sort submenu
under the Edit menu.  The messages are sorted when the mouse button is released.
Eudora sorts in ascending order; the smallest item first.  To sort in descending
order, hold down the [Shift] key when doing the sort.

The Sort submenu

Tip: Eudora’s sorting algorithm is “stable.”  This means that sorting
on a particular column leaves items of the same value in the same
order as they were before the sort.  This feature allows you to sort
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based on multiple criteria by using multiple sort commands.  For
example, if you want your messages sorted by subject, and within
each subject you want messages sorted by date, first choose Sort
by Date, then Sort by Subject.

Note: Sometimes Eudora does not sort by date properly.  This happens if
the messages have incorrectly formatted date fields or unknown or
incorrect time zones.  Also, since Eudora uses Greenwich Mean
Time (GMT) when sorting by date, the messages may merely
appear to be out of order because the time stamp is the local time
at the location where the messages originated.  For example, a
message sent at 11:30 EST is listed before a message sent at 10:00
PST, because 11:30 EST actually occurs before 10:00 PST.

Saving a Message to a File

Eudora allows you to save a current message(s) to a separate text file on your PC.
To do this, first display the desired message or highlight its summary in the
mailbox window.  Then, select Save As... from the File menu.  The Save As
dialog is displayed, allowing you to choose a name and location for the file.

The Save As dialog

Note the two options at the bottom of the dialog.  Guess Paragraphs instructs
Eudora to remove extraneous carriage returns from the message, leaving returns
only at the ends of paragraphs.

Include Headers instructs Eudora to retain the message’s header information in
the saved document.  If this is unchecked, only the body of the message is saved.

Once you’ve made all of your choices, click on the OK button in the dialog.
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If you select multiple messages from a mailbox window and select Save As..., all
of the messages are saved to a single file.

Using “Save As...” to save several messages to one file

Tip: When Eudora receives a very large message from the POP server,
it splits that message into multiple smaller messages. If you need to
reassemble the original message, use the Save As... command.

Resending Rejected Messages

Mail Transport Agents are computer programs responsible for routing e-mail
messages through networks.  If for some reason an e-mail message can’t be
delivered to an intended recipient, these programs return the message to the
original sender.  A message is typically rejected because of an error in the
recipient’s address, although there are many possible reasons.

The message sent back from the mail system usually includes cryptic information
that may allow you to determine the reason for the message being rejected.  It
also includes the text of the original message.



Reference Eudora User Manual

80 QUALCOMM Incorporated

A rejected message

If you choose to resend the message, Eudora deletes the error messages and added
text and recovers the original message so that you can make any corrections.  To
do this for the current message, select Send Again from the Message menu.  This
eliminates the inserted extra text and reformats the message as it originally
appeared.   You can then make changes or additions and resend the message, if
desired.

Message Priorities

Eudora allows you to assign priorities to your messages.  These priorities are for
sender/recipient reference purposes only, and they do not affect the way Eudora
handles the messages.

There are five priority levels available, each represented by a small icon.
Priorities range from 1 (highest) to 5 (lowest).  Priority 3 is assumed for messages
that have no assigned priorities, and it is not displayed.

Highest priority.

High priority.

<blank> Normal priority.

Low priority.

Lowest priority.

Message priorities are displayed in the Priority column of the mailbox window.
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Message priorities displayed in the mailbox window

Priorities can be changed in open message windows by selecting the desired
priority from the Priority combo box on the icon bar.  The selected priority icon
is then displayed in the combo box.

Assigning a priority to a message

You can also change the priority of the current message(s) by holding down the
[Ctrl] key and pressing a number key from 1 to 5 (1 = Highest, 5 = Lowest).

When you send mail with a priority other than Normal, Eudora adds an X-
Priority: header to the mail.  The header lists the assigned priority.

Note: All new messages are created with Normal priority, even replies to
messages whose priority you have changed.  The exception to this
is that, if the sender of a message gives it a priority other than
normal, and the Copy original’s priority to reply option in the
Settings dialog (Replying) is turned on, Eudora gives your reply
the same priority as the original message.  This occurs even if you
reassign the priority of the sender’s message after you have
received it.  You can, however, change the priority of your
response by re-assigning it manually.

Editing Message Subjects

Sometimes the subject of a message is not clear or descriptive.  Eudora allows
you to edit the subject of any incoming message.
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Note: The subjects of outgoing messages (messages sent by you) cannot
be edited.

To edit the subject of an incoming message, open it from its mailbox window.
Notice that the subject is displayed below the title bar and above the message.
You can edit this text as you would any other text.  When editing is complete,
close the message.  The new subject is displayed in the message summary.  The
contents of the Subject: field of the message header remain unchanged.

Editing the subject of an incoming message

After Editing the subject

Note: If you reply to the message, the original subject is used for the
reply, not your changed subject.  This gives you the freedom to put
information useful to you into the summary, without fear of your
private notes being revealed to your correspondents.

Using the Ph Window

Eudora can access two different directory services, Ph and Finger, via the Ph
window.  To display the Ph window, select Ph from the Window menu.

The Ph window has two buttons (one for Ph and one for Finger), and three text
fields:  one where you specify which server to use (Server); one where you type
your query (Command); and one where you see the response.
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Using Ph
To use the Ph protocol, type the name of the Ph server in the Server field or use
the default server (the default is what is entered in the Ph field of the Settings
dialog [Hosts]).  Then, type the name of the person you want to look up in the
Command field and click on the Ph button.  The server’s response is displayed in
the response field.

A Ph query and its response

Note: You can type any Ph command in the query field, except login
commands or commands requiring login.  For more information
about the Ph server source code, see Appendix A.

Using Finger

To use the Finger protocol, type your query into the query field.  This query
should be in the form “name@domain.”  If you omit the “@domain” segment,
Eudora uses the server listed in the Server field.  Once the name is entered, click
on the Finger button.

The finger query is sent to the host specified in the “@domain” part, and the
response is displayed in the response field.

Creating a Signature

A “signature” is a brief message automatically added by Eudora to the end of
outgoing messages.  It should consist of a few lines giving the sender’s full name
and e-mail address.  Other pertinent details, such as phone number, postal
address, or place of employment are also sometimes included.

To create a signature, select Signature from the Window menu.  A blank
Signature window is displayed.  Type your signature text in this window.
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Typing a signature

When you are finished typing the signature, close the Signature window.  An alert
is displayed asking if you want to save the changes to your signature.  Click Save.
You may modify your signature at any time by repeating this procedure.

In order to activate your signature on an outgoing message, click on the Signature
icon in the icon bar.

Activating your signature in the icon bar

Note: The signature text is not displayed at the end of messages you
create, but your recipients see it.

Settings Dialog

The Settings dialog allows you to configure Eudora.  To display the Settings
dialog, select Settings... from the Special menu.

The Settings dialog contains the following categories of settings and options:
Getting Started, Personal Information, Hosts, Checking Mail, Sending Mail,
Attachments, Fonts & Display,  Getting Attention, Replying,  Miscellaneous, and
Advanced Network.  Each of these categories is described below.  The default
settings are listed in brackets after the name of each setting/option.
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Note: For your convenience, some settings appear in more than one
category.  For example, your real name appears in both the
Getting Started and Personal Information categories.  Changing a
setting in one category changes the setting in all categories.

Getting Started Settings

The Getting Started settings provide Eudora with the minimum user account
information necessary to send and receive mail.

The Getting Started settings

POP account: [none]
To receive mail with Eudora, you must have an account on a computer that runs a
Post Office Protocol version 3 (POP3 or POP) server.  This is the account to
which your e-mail messages are delivered before they are transferred to the
Eudora program on your PC.  Enter your login name for this account, followed
by an “@” sign and the domain name of the computer.

For example, if your login name for your POP account is “jbdorn,” and the name
of the computer is “action.com,” type jbdorn@action.com in this field.

Real name: [none]
Enter your real name here.  It is placed in the From field of your outgoing mail
messages, along with your return address.

Connection Method:
Select Offline if you don’t want Eudora to attempt to make any connections.
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Personal Information Settings

The Personal Information settings provide Eudora with your personal
information.

The Personal Information settings

POP account: [none]
This is your POP account address.

Real name: [none]
This is your real name.

Return address: [none]
Normally, Eudora uses your POP account as your return address.  If you wish to
use a return address other than your POP account, enter it here.

Note: If you do enter an address in this field, first test the address to be
sure that mail sent to it is indeed delivered to you.  If you use an
invalid return address, no one can reply to your mail.

Hosts Settings

The Hosts settings provide Eudora with information about your servers.
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The Hosts Settings

POP account: [none]
This is your POP account address.

SMTP: [none]
To send mail, a computer with an SMTP (Simple Mail Transfer Protocol) server
program is necessary.  You need not have a login on this computer, but you must
have access to it through your network.  If the computer on which you have your
POP account is also an SMTP server, leave this field blank.  Otherwise, specify
the name of the computer that you want to use as your SMTP server.

Ph: [none]
Enter the host name of your Ph name server here.

Finger: [none]
Enter the host name of your Finger server here.  If you leave this blank, Eudora
uses your SMTP server as your Finger server.

Checking Mail Settings

The Checking Mail settings determine how Eudora checks for and receives your
incoming mail messages.
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The Checking Mail settings

POP account: [none]
This is your POP account address.

Check for mail every  ?  minute(s) [0]
If you enter a number in this field, Eudora checks your POP server for new mail
at regular intervals and transfers any mail addressed to you to your PC.  The
number you enter specifies the number of minutes between checks of the POP
server.  It’s a good idea to set this at no less than 15 minutes.  Checking mail
more frequently puts an unnecessary drain on your POP server.  This option only
works when Eudora is running.  Setting this field to 0 disables automatic
checking.

Skip big messages [off]
If this option is on, Eudora does not download the entire texts of messages over
40k, but only downloads the first few lines.  This can be useful on slow
connections.

Note: See the “Incoming Message Window” section for information on
how to download messages that have been skipped.

Send on check [on]
If Send on Check is on, Eudora automatically sends any messages that are queued
in the Out mailbox whenever it checks the POP Server for new mail.

Save password [off]
If Save Password is on, you never have to enter your password to check your mail
(even if you quit Eudora and restart it) because your password is stored on your
PC.  Only use this option if your PC is in a secure place.
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Leave mail on server [off]
Eudora normally transfers your incoming messages from your account on the
POP server to your PC, and then deletes them from the POP server.  If this option
is on, Eudora transfers incoming messages to your PC and also keeps copies on
the POP server.

Authentication Style [Passwords]
Eudora supports the use of two network authentication technologies: Passwords
and APOP.  Ask your e-mail administrator which one is being used at your site.

Sending Mail Settings

The Sending Mail settings determine how Eudora sends your outgoing mail
messages.

The Sending Mail settings

Return address: [none]
If you wish to use a return address other than your POP account, enter it here.

Note: If you do enter an address in this field, first test the address to be
sure that mail sent to it is indeed delivered to you.  If you use an
invalid return address, no one can reply to your mail.

SMTP server: [none]
Specify the name of the computer which you want to use as your SMTP server.
If you leave this field blank, Eudora uses your POP server as your SMTP server.
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Immediate send [on]
If this option is on, the rightmost button in the icon bar of the message
composition window is labeled Send.  Clicking on this button immediately sends
the message to the SMTP server.  If this option is off, the button is labeled Queue
and clicking on it places the message in the Out mailbox marked ready for
delivery (Q).

Send on check [on]
If this option is on, Eudora automatically sends any messages that are queued in
the Out mailbox whenever it checks the POP server for new mail.

Word wrap [on]
If this option is on, a carriage return is not required at the end of each line of type
in an outgoing message.  Eudora automatically wraps text to the next line, with
line breaks at roughly 76 characters per line.  This makes your mail more legible
to recipients using line-oriented mail systems.  It is strongly recommended that
you turn this option on.

Fix curly quotes [on]
If this option is on, Eudora replaces all “smart” quotation marks in message text
or attachments with "conventional" quotation marks prior to sending the
message/attachment.  The “smart” quotation marks are special characters, and this
option allows messages to be sent without using quoted-printable encoding.

Note: If your recipients have MIME, there’s no reason to use this option.
Only turn it on if most of the people you correspond with don’t use
MIME.

May use Quoted-Printable [on]
If this option is on, Eudora uses quoted-printable encoding when necessary, such
as when messages that contain long lines of text or special characters are sent.  If
this option is off, quoted-printable encoding is never used.

Keep copies of outgoing mail [on]
If this option is on, a copy of each sent message is kept in the Out mailbox (their
summaries are marked with an “S” in the Status column of the Out mailbox
window).  If this option is off, Eudora moves outgoing messages to the Trash
mailbox after they are sent.

Use signature [on]
If this option is on, Eudora automatically attaches your signature file (if you have
one) to the end of outgoing messages.

Tabs in body of message [on]
If this option is on, hitting the [tab] key within the message body results in
Eudora inserting enough spaces to move the insertion point to the next tab stop.

Attachments Settings

The Attachments settings determine how Eudora sends and receives attachments.
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The Attachments settings

Encoding Method [MIME]
This option allows you to select what format documents attached to outgoing
messages are encoded in MIME or BinHex.  MIME is best for recipients with
MIME and BinHex is most compatible with old Macintosh mailers and previous
versions of Eudora.

Put text attachments in body of message [off]
This option causes Eudora to place any plain text attachment you send directly in
the message body, as if it were typed in manually.

Attachment Directory: [none]
Eudora automatically places file attachments that come with messages into the
specified Attachment Directory.  To change the setting, single-click on the
directory name button (the default is blank).  A dialog is displayed allowing you
to select the attachment destination directory.

Note: If you do not select an attachment directory, attachments are
placed in your Eudora directory.
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Fonts & Display Settings

The Fonts & Display settings determine how Eudora displays messages.

The Fonts & Display settings

Screen Font: [Courier New,9]
This field lists the font to be used for displaying the text of your Eudora messages
and mailbox windows.  It also lists the point size of the font.  To change the
selection, click on this field.  The Font dialog is then displayed, allowing you to
select a new font and size.

The Font dialog
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Print Font: [Courier New,12]
This field lists the font to be used when printing messages using the Print...
command.  It also lists the point size of the font.  To change the selection, click
on this field.  The Font dialog is then displayed, allowing you to select a new font
and size.

Message Window Width: [80]
This field specifies the width of new and received message windows (in
characters).  If you leave this field blank, the default value is 80.  This setting has
no effect on what your mail looks like when it is sent.  When mail is sent, Eudora
wraps at or before 76 columns.

Note: If you use a proportional font, Eudora sets the window width based
on the average width of the characters in the font.

Message Window Height: [20]
This field specifies the height of new and received message windows (in lines).
If you leave this field blank, the default value is 20.

Note: If the Zoom windows when opening option is turned on, received
message window heights are automatically adjusted to the height
of the message text.

Zoom windows when opening [on]
If this option is on, new message windows automatically open to their “zoomed”
size.  The zoomed size is computed on a window-by-window basis.  For message
windows, zoomed size is just long enough to display all of the message (but no
longer than the main window), and as wide as the Message Window Width
setting.  Composition windows zoom to the height specified by the Message
Window Height setting.

Show all headers (even the ugly ones) [off]
If this option is on, Eudora displays the complete message header of incoming
messages, including the routing information.

Show toolbar [on]
If this option is on, the main window toolbar is displayed (see the “Main Window
Toolbar” section).

Show toolbar tips [on]
If this option is on, holding the mouse pointer over a button in the main window
toolbar displays a very brief description of that button’s function.

Show status bar [on]
If this option is on, Eudora displays a status bar at the bottom of the main
window.  The status bar provides a brief description of menu items and toolbar
buttons.

Show category icons [on]
This option allows you to turn the Category icons in the Settings dialog on and
off.
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Settings dialog with Category icons turned off
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Getting Attention Settings

The Getting Attention settings determine what Eudora does when new mail
arrives.

The Getting Attention settings

Use an alert dialog box [on]
If this option is on, Eudora uses an alert dialog to notify you when new mail is
received.

Open mailbox [on]
This option applies only to the arrival of new mail.  If it is on, Eudora
automatically opens mailboxes when new mail arrives and is placed in them.  It
also scrolls to the end of the mailboxes and selects the first unread message of the
last unread batch of messages.  If this option is off, Eudora doesn’t open
mailboxes when new messages arrive.

Play a sound [on]
If this option is on, Eudora makes a noise when new mail arrives.  To select a
sound (.wav) file, click on the field below the Play a sound option.  The Select
sound file dialog is then displayed, allowing you to select a sound.
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Replying Settings

The Replying settings determine what Eudora does when you are generating
replies to incoming messages.

The Replying settings

Reply to all (otherwise when Shift is down) [off]
If this option is on, selecting Reply from the Message menu creates a message
addressed not only to the sender of the original message, but also to all of its
recipients.  If this option is off, the [Shift] key must be depressed when creating
the reply message if you want to do a reply to all.  Otherwise, the reply message
is only addressed to the original sender.

When replying to all:

Include yourself [off]
If this option is on, when you do a Reply to all (as described above) your address
is left in the address list of the new message and you receive a copy of your own
reply.  If this option is off, your address is removed from the reply message and
you do not receive a copy of the reply.

Note: To determine who you are, Eudora uses the “me” nickname, if you
have one.  If not, it uses the contents of the POP Account and
Return Address fields from the Settings dialog (Getting Started).

Put original To: recipients in Cc: field [off]
If this option is on, the addresses of the original message recipients are moved
from the To: field to the Cc: field of the reply to all message.  Only the address of
the original sender is placed in the To: field.
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Copy original’s priority to reply [on]
If this option is on, a reply message generated by you will have the same priority
as the original message.

Miscellaneous Settings

These settings control miscellaneous functions.

The Miscellaneous settings

Switch messages with:

Unmodified arrow keys [off]
If this option is on and there is an incoming message window open on the screen,
the keyboard arrow keys can be used to close the current message and open the
next or previous message in the mailbox.  The up or left arrow key opens the
previous message; the down or right arrow key opens the next message.  If this
option is off, the arrow keys can be used to move the caret in messages.

Note: Even if Unmodified arrow keys is on, the arrow keys do not switch
messages if there is a message composition window topmost on the
screen.

Alt+arrow keys [off]
If this option is on, you can switch messages (as described in the “Unmodified
arrow keys” section above) by holding down the [Alt] key and then pressing the
arrow keys.

Note: The Alt+arrow keystrokes do work when composition windows are
open on the screen.
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Require confirmation for deletes [on]
If this option is on, Eudora alerts you when you are deleting messages you
haven’t read or transferring queued messages out of the Out mailbox.

Close messages with mailbox [off]
If this option is on, closing a mailbox window closes all open messages from that
mailbox.

Empty Trash when exiting [off]
If this option is on, Eudora empties the Trash mailbox whenever you exit the
application.  If Empty Trash when exiting is off, Eudora only empties the Trash
when you select Empty Trash from the Special menu.

Note: If you want to remove some messages from the Trash mailbox but
don’t want to empty it entirely, highlight the summaries you want
to delete and select Delete from the Message menu.  The selected
messages are deleted.

Say OK to alerts after  2 minutes [on]
Many network problems are temporary. When a problem occurs while Eudora is
transferring or checking your mail, you are notified in the same way you would
be if you were receiving new mail. If this option is on, these notifications
automatically go away after 2 minutes. This allows Eudora to try the
communication again. This setting is most useful if you have automatic mail
checking enabled.

Automatically open next message [off]
If this option is on, deleting or transferring the current message opens the next
message in the mailbox, but only if it is unread.

Advanced Network Settings

These settings control some of Eudora’s advanced network functions.  They
should not be modified without first consulting with your Eudora support
coordinator or service provider.
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The Advanced Network settings

Use asynchronous Winsock calls for:
This option allows you to select asynchronous calls for All non-database
functions or Database functions when using the Winsock connection method.
There are two methods of making Winsock calls using TCP/IP stacks, blocking
and asynchronous.  Because of the ability to handle error conditions more
gracefully, asynchronous is the preferred method when using Eudora.  However,
some TCP/IP stacks do not handle asynchronous calls correctly.  If you’re
experiencing trouble with your Winsock connection, make sure both of these
options are off.

Network timeout after ? seconds [45]
This option allows you to set the number of seconds before a network connection
will time out.

Network buffer size of ? bytes [4096]
This option allows you to set the size of the buffer that Eudora uses to transfer
information to and from the server.

Note: If you are having trouble transferring large messages, the size of
this buffer may be decreased.

Cache network info
This option causes Eudora to remember the results of previous database functions
when using the Winsock connection method.  This speeds up database functions
within a single Eudora session.
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Printing

Eudora can print a current message or messages, your signature, or the contents
of the Ph window.  To print from within Eudora, select Print... from the File
menu with the message or Ph window displayed.  Eudora automatically prints
headers and footers on each page, giving the window title, page number and your
return address.

Quitting Eudora

To quit the Eudora program, select Exit from the File menu.  If you have queued
messages, or timed messages due to be sent in the next 12 hours, you are asked if
you want to send them (see the “Quitting with Queued Messages” section).  If the
Empty Trash on Quit option in the Switches dialog is turned on, quitting Eudora
also empties your Trash mailbox.

Mail Storage

When you install Eudora, it creates a number of files within the assigned
directory.  In addition, Eudora creates additional files as needed for mailboxes,
signatures, and other settings.  The Eudora files are described below.

eudora.ini

Your Settings information is saved in the eudora.ini file, along with other
information.

nndbase.txt

Your nicknames are saved in the nndbase.txt file.

nndbase.toc

This file is the table of contents for your nicknames.

in.mbx, out.mbx, trash.mbx

These files hold your mail.  You’ll see files like these for every mailbox you
create.

Note: These files are in UNIX mail format.

in.toc, out.toc, trash.toc

These files are the tables of contents for your mailboxes.  They make it much
faster for Eudora to access your mail.  You’ll see files like these for every
mailbox you create.

lmos.dat

This file contains information about the messages on your mail server.
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eudora.log, eudoralog.old

Eudora can keep records of all mail transfers.  These records are kept in the
eudora.log and eudoralog.old files.  The eudoralog.old file is overwritten and a
new eudora.log file is created when the eudora.log file reaches its approximately
100K maximum size.  To enable logging, set the LogLevel entry in the [Debug]
section of the EUDORA.INI file.

signatur.pce

The signature is kept in the signatur.pce file.

descmap.pce

Mappings between mailbox names and DOS 8.3 file names are stored in the
descmap.pce file.

Sharing a PC with Other Users

If you are sharing a PC with other users, make a separate mail directory and
create a separate program item for each user.  The directories can be named
whatever you like, and put anywhere you like, including on floppies or network
drives.  To tell Eudora which directory to use, specify that directory as the first
parameter on the Command Line of the Program Item Properties dialog.

Specifying a mail directory
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Summary of Eudora Menu Commands

File

This menu provides basic file and mail program functions.

Close
Close the current window.

Save
Save changes to the contents of the topmost window.
This applies to composition windows, signature
windows,  and the Nicknames window.

Save As...
Save the current message(s) to a plain text file.

Send Queued Messages
Send all messages that have been queued for delivery.

Check Mail
Pick up new mail from the POP server.  The time in
parentheses (if displayed) indicates the next time
Eudora will automatically check for mail.

Print...
Print the current message(s), Ph window, or
Signature..

Print Setup...
Set printing options.

Exit
Exit the Eudora application.
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Edit

This menu provides text editing and sorting tools.

Undo
Reverse the last editing action taken on a piece of text.

Cut
Delete selected text and place it on clipboard.

Copy
Copy selected text and place it on clipboard.

Paste
Place contents of clipboard at insertion point.

Paste as Quotation
Place contents of clipboard at insertion point, with a
‘>’ at the beginning of each line to denote quoted text.

Clear
Delete selected text.

Select All
Select entire contents of message or mailbox.

Wrap Selection
Insert carriage returns at the end of each line of the
current selection.  With the [Shift] key, unwrap text.

Finish Nickname
Complete the text of a nickname in a message header.

Insert Recipient
Insert the chosen nickname/address from the Quick
Recipient list at the insertion point.

Find submenu
Search for designated text or character string within
message(s).

Sort submenu
Sorts message summaries in a mailbox.  Hold down
the [Shift] key to reverse the order of the sort.
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Mailbox

This menu lets you open a mailbox, or bring an open mailbox to the front.

In
Open mailbox where incoming messages are stored
until deleted or transferred to another mailbox.

Out
Open mailbox where messages you compose are
stored, and where queued messages are held until
actually sent, and where copies of sent messages may
be initially stored.

Trash
Open mailbox where deleted messages are stored.

New...
Display New Mailbox dialog to create a new mailbox.

[Your Mailboxes]
Mailboxes you create are also displayed in this menu.
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Message

This menu lets you create and delete messages.

New Message
Open new message composition window.

Reply
Reply to the sender of the current message.

Forward
Forward the current message to someone else.

Redirect
Forward the current message to someone else, but
make the return address be the person who originally
sent the message.

Send Again
Resend a message rejected by the mail system.  Be
sure to fix whatever caused the problem before you
queue the message.

New Message To
Send a message to someone on the Quick Recipient
list.

Reply To
Reply to the current message, but send the reply to
someone on the Quick Recipient list.

Forward To
Forward the current message to someone on the
Quick Recipient list.
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Redirect To
Redirect the current message to someone on the
Quick Recipient list.

Queue For Delivery/Send Immediately
Save the message in the Out mailbox and mark it as
queued (ready to be delivered), or send it
immediately.

Note:   This menu item toggles based on the Immediate Send
option in the Switches dialog.

Attach File...
Attach file(s) to the current message.

Change
Change Queueing and Priority options.

Delete
Transfer the current message to the Trash mailbox;
also used for deleting messages from the Trash
mailbox.

Transfer

This menu lets you transfer current message(s) to the selected mailbox.

In
Transfer the current message(s) to the In mailbox.

Trash
Transfer the current message(s) to the Trash mailbox.

New...
Display New Mailbox dialog to create a new mailbox.
Current message(s) may be transferred into it.

[Your Mailboxes]
Transfer the current message(s) to the selected
mailbox that was previously created by you.
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Special

This menu provides additional Eudora functions.

Make Nickname...
Create abbreviations for addresses in the current
message.

Add As Recipient
Add selected text to the Quick Recipient list.

Remove Recipient
Select a recipient from this menu and the recipient is
removed from the Quick Recipient list.

Empty Trash
Delete all messages from the Trash mailbox.

Compact Mailboxes
Reclaim unused space in all mailboxes.

Settings...
Display the Settings dialog.

Forget Password
Make Eudora ask for your password the next time it
checks for mail.

Change Password
Change your password on the POP server computer.
This requires a special server.
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Window

All Eudora window titles are listed in this menu.  Select one to open it or bring it to the front.

Cascade
Cascade open windows.

Tile Horizontal
Tile open windows horizontally.

Tile Vertical
Tile open windows vertically.

Arrange Icons
Arrange all icons at the bottom of the main window.

Send to Back
Send the topmost current window to the back of all
displayed windows.

Mailboxes
Display the Mailboxes window.

Nicknames
Display the Nicknames window.

Ph
Display the Ph window.

Signature
Display the Signature window.
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Help

The Eudora Help menu and About Eudora screen are listed in this menu.

Contents
Display the on-line help contents.

Search for Help on...
Display a list of search topics.

How to Use Help
Display the Microsoft Windows How to Use Help
window.

QUEST News
Display a subscription dialog for the QUEST News
mailing list.

Eudora Forum
Display a subscription dialog for the Windows
Eudora Forum mailing list.

About Eudora Pro
Display the About Eudora Pro screen.

About Eudora...
Display the About Eudora screen.
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Appendix A – Sources

Anonymous ftp (ftp.qualcomm.com)

QUALCOMM has an anonymous ftp server (ftp.qualcomm.com) that has
information and software related to Eudora.  These are located within the “quest”
directory.  Included are POP3, Ph, and password changing servers,  current
product information, and more.

Eudora Information

The information in this manual was correct at the time of printing.  However,
things happen very quickly in the electronic world, meaning that some of this
information may already be out of date.  For the very latest information about
Eudora, send e-mail to eudora-info@qualcomm.com.  The text of the message
should consist of “sub eudora your-first-name your-last-name”.  Be sure you
don’t put anything else in the body of the message, including your signature.

Obtaining a POP Server

If you would like to run a POP server on your own UNIX system, we suggest you
use “popper.”  Popper is available via anonymous ftp from ftp.qualcomm.com.
Popper versions are available for a number of UNIX systems.

VAX/VMS systems may try the “Multinet” package from TGV, or IUPOP3,
available via anonymous ftp from ftp.indiana.edu.

For VM/CMS users, there is a port of “popper” available via anonymous ftp from
vmd.cso.uiuc.edu (cd to the “POPD” directory).

Ph Server Source Code

A server for the “Ph” protocol is available via anonymous ftp from
ftp.qualcomm.com.

Password Change Server

Three sample UNIX servers for Eudora’s “Change Password” command are
available via anonymous ftp from ftp.qualcomm.com.

Windows Sockets Products

Demos of Windows Sockets 1.1 compliant stacks and applications are available
via anonymous ftp from sunsite.unc.edu in the directory micro/pc-stuff/ms-
windows/winsock.  The are also available on ftp.cica.indiana.edu in the directory
pub/pc/wins/winsock.
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Serial Line IP (SLIP)

Information and applications regarding Serial Line IP (SLIP) are available via
anonymous ftp from biochemistry.cwru.edu in the directory /slip.

PC Speaker

If you want the new mail sound notification to work with the speaker that comes
with your PC, you need to install the PC speaker driver.  This driver is available
via anonymous ftp from ftp.qualcomm.com.  It’s the file SPEAK.EXE in the
directory quest/eudora/windows/utils.  This is a self-extracting archive, so just run
it on your PC to produce the necessary files and instructions.
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Appendix B – Shortcuts

Modifier Keys

Many operations in Eudora can be affected by holding down one or more
“modifier” keys.  Eudora uses the [Shift] and [Ctrl] keys as modifiers.

The [Shift] key is usually used to make an operation to reverse option settings.

● [Shift] + Insert a nickname inserts the full nickname expansion in the
specified field.

● [Shift] + Finish Nickname inserts the full nickname expansion in the
specified field.

● [Shift] + Save saves changes to any open windows.

● [Shift] + Queue or Send button brings up Change Queueing dialog.

● [Shift] + Reply toggles the “Reply to all” option in the Settings dialog
(Replying).  If the Reply to all option is turned on, Shift + Reply generates a
reply to the sender only.  If the Reply to all option is turned off, Shift + Reply
generates a reply to all addresses in the message header.

● [Shift] + Transfer sends a copy of the current message to the selected
mailbox and retains the original message in the original mailbox.

● [Shift] + Copy unwraps (removes the extra carriage returns) the selection
prior to copying it to the clipboard

● [Shift] + Wrap Selection unwraps (removes the extra carriage returns) the
selection.

● [Shift] + Open a message shows all headers.

● [Shift] + Close closes all open windows.

● [Shift] + Exit instructs Eudora that all open windows are to automatically
reopen at the next startup.  It does not quit Eudora.
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Other Important keys

The arrow keys, depending on the options in the Settings dialog (Miscellaneous),
can move you from one message to another in a mailbox.  If the Unmodified
arrow keys or Alt-arrow keys options are turned on,

● up/left arrow or [Alt] + up/left arrow takes you to the previous message.

● down/right arrow or [Alt] + down/right arrow takes you to the next
message.

The [Enter] key performs several different functions:

● It selects the outlined button in any dialog, alert, or window.

● It opens the selected message(s) in a mailbox.

● It lets you begin or end editing the subject of a message.

The [Esc] key stops any operation currently in progress.

The [F1] key displays the On-Line Help menu.

If you have an extended keyboard, the following keys are also useful:

● [Delete] deletes the character to the right of the insertion point.

● [Home] moves the caret to the beginning of a line.

● [End] moves the caret to the end of a line.

● [Page Up], [Page Down] scrolls up or down through the window.

[Ctrl] + Key Equivalents

[Ctrl] + [A] Select all

[Ctrl] + [B] Move window behind all other windows

[Ctrl] + [C] Copy

[Ctrl] + [D] Delete message

[Ctrl] + [E] Queue/Send an outgoing message

[Ctrl] + [F] Open Find window (search for message)

[Ctrl] + [G] Find again

[Ctrl] + [H] Attach file to outgoing message

[Ctrl] + [I] Open In mailbox

[Ctrl] + [K] Make nickname

[Ctrl] + [L] Open Nicknames window

[Ctrl] + [M] Check mail

[Ctrl] + [N] New message
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[Ctrl] + [P] Print message

[Ctrl] + [Q] Quit Eudora

[Ctrl] + [R] Reply to message

[Ctrl] + [S] Save contents of topmost window

[Ctrl] + [T] Send queued messages

[Ctrl] + [U] Open Ph window

[Ctrl] + [V] Paste

[Ctrl] + [W] Close message

[Ctrl] + [X] Cut

[Ctrl] + [Z] Undo





QUALCOMM Incorporated 117

Appendix C – Mail Transport

Introduction

Eudora uses Simple Mail Transfer Protocol (SMTP) to transfer your outgoing
mail to your SMTP server machine, which in turn uses SMTP to send your mail
to the world at large.  Mail from the world at large arrives on your Post Office
Protocol (POP) server, where it waits for Eudora to pick it up with Post Office
Protocol, version 3 (POP3).  The mail Eudora sends and receives is constructed in
accordance with RFC 822 and RFC 1521 (MIME).

Eudora mail transport overview

Outgoing Mail

When you send an e-mail message to someone, Eudora uses SMTP to send the
mail to your local SMTP server computer.  That computer then sends the mail to
your addressee’s computer, also (usually) by means of the SMTP protocol.

Why doesn’t Eudora talk directly to your addressee’s computer?  For one thing, it
would take a lot longer for your mail to leave your PC, because your PC would
have to call up each addressee’s computer and deliver your mail.  For another,
some computers are “hard to find;” it’s much better to let another computer
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“hunt” for your addressee than to make your PC do it.  Finally, sometimes your
addressee’s computers won’t be available when you want to send mail.  The
SMTP server handles this by holding your mail until the other computer is ready
to accept  it, eliminating the inconvenience of having unsent messages hanging
around on your PC.

Incoming Mail

When somebody sends you mail, other computers use the SMTP protocol to
deliver the mail to your POP server.  Your POP server puts mail in your “mail
drop,” where it stays until the Eudora program picks it up.  When you check your
mail, Eudora uses POP3 to pick up your mail and move it to your PC.

Why doesn’t Eudora use SMTP to receive your mail?  SMTP works best when
the computers it knows about are always ready for mail.  Unless you wanted to
run Eudora and your PC 24 hours per day, seven days a week, SMTP wouldn’t
work very well for you.  It also doesn’t work well in lab environments, where you
might use any number of different PCs.

More Information

If you want to know more about the Internet in general, consult the book
Internetworking with TCP/IP, by Douglas Comer, 1988, Prentice-Hall ISBN 0-
13-470154-2 025.

If you want to know more about SMTP, RFC 822, POP3 and MIME, the official
standards are:

RFC 821, “Simple Mail Transfer Protocol,” by Jonathan B. Postel

RFC 822, “Standard for the Format of Internet Text Messages,” by Dave Crocker

RFC 1725, “Post Office Protocol, Version 3,” by Marshall Rose

RFC 1521, “Multipurpose Internet Mail Extensions,” by Ned Freed and Nathaniel
Borenstein

You can find the RFC’s by anonymous ftp to nic.ddn.mil; see Internetworking
with TCP/IP for details.
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Appendix D – MIME and Mapping

What is MIME?

“MIME” stands for Multipurpose Internet Mail Extensions.  MIME serves two
major purposes – it allows mail applications to tell one another what sort of data
is in mail, and it also provides standard ways for mail applications to encode data
so that it can be sent through the Internet mail system.

MIME Encoding

The Internet uses the “SMTP” protocol to move mail around.  SMTP is limited to
the US-ASCII character set (see Appendix C).  This is a problem for people who
speak languages other than American English and so need accented characters or
non-American letters, or for people who want to use special symbols like the
bullet.

MIME provides a way around this restriction.  It offers two encodings, “quoted-
printable” and “base64.”  These encodings use US-ASCII character codes to
represent any sort of data you like, including special characters or even non-text
data.

Quoted-printable is used for data that is mostly text, but has special characters or
very long lines.  Quoted-printable looks just like regular text, except when a
special character is used.  The special character is replaced with an “=” and two
more characters that represent the character code of the special character.  So, a
bullet in quoted-printable looks like “=95.”

However, there are some other things that quoted-printable does.  For one, since
it uses an “=” to mean something special, equal signs must themselves be encoded
(as “=3D”).  Second, no line in quoted-printable is allowed to be more than 76
characters long.  If your mail has a line longer than 76 characters, the quoted-
printable encoding will break your line in two, and put an “=” at the end of the
first line, to signal to the mail reader at the other end that the two lines are really
supposed to be one.  Finally, a few mail systems either add or remove spaces
from the ends of lines.  So, in quoted-printable, any space at the end of a line gets
encoded (as “=20”) to protect it from such mail systems.

Let’s try an example.  Here’s a passage of text that you might type on your PC:

«Il est démontré, disait-il, que les choses ne peuvent être

autrement; car tout étant fait pour une fin, tout est

nécessairement pour la meillure fin.»Error! Reference source not

found.

Without any encoding, this might show up on your recipient’s screen as:
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+Il est dimontri, disait-il, que les choses ne peuvent btre

autrement; car tout itant fait pour une fin, tout est

nicessairement pour la meillure fin.;

This corruption happens because SMTP cannot handle the special characters.
However, if you and your recipient both have MIME, quoted-printable encoding
would be used, and your text would show up properly. While your mail was
actually in transit, however, it would have looked like:

=ABIl est d=E9montr=E9, disait-il, que les choses ne peuvent =EAtre =

autrement; car tout =E9tant fait pour une fin, tout est n=E9cessairement =  pour

la meillure fin.=BB

Base64 encoding is another way to protect binary data from the SMTP mail
system.  However, Base64 makes no attempt to be legible, and is most
appropriate for non-text data.

MIME Labelling

The other important part of MIME is that it lets mailers communicate what kind
of data is in a message (or part of a message).  The primary mechanism used for
this is the Content-Type header:

Content-Type: text/plain; charset=iso-8859-1

A content-type header is divided into three parts; the content type, the content
subtype, and the parameters.  In this case, the content type is “text,” meaning the
message contains mostly legible text.  The content subtype is “plain,” which
means there aren’t any formatting commands or anything like that embedded in
the text.  Finally, “charset=iso-8859-1” is a parameter; in this case, it identifies
the character set the message uses.

The major content types are:

text legible text

image pictures and graphics

audio sound

video moving pictures

message messages or pieces of messages

multipart several different kinds of data in a single message

Practical Issues

There are really only two things you sometimes need to do with Eudora and
MIME.  One is that it may occasionally be necessary to turn off quoted-printable
encoding.  Another is that you may want to know how to define mappings
between PC file extensions, MIME types, and Macintosh types.
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Turning Off Quoted-Printable Encoding

Eudora automatically uses quoted-printable encoding if your mail contains special
characters.  Eudora also uses quoted-printable encoding for attached plain text
files.  If your recipients don’t have MIME, quoted-printable may hurt more than
it helps.  If that’s the case, just turn off the QP button in the message icon bar
when you are sending text files to those recipients.

Turning off Quoted-Printable Encoding

Mapping Between File Extensions, MIME Types, and Macintosh
Types

Since Eudora needs to have the appropriate extensions on attachment filenames in
order to open them up from the message, Eudora has the ability to map between
file extensions, MIME types and subtypes, and Macintosh creators and types.
Messages received by Eudora can grab the MIME type/subtype and/or Macintosh
creator/type from an attachment and map that into the correct file extension.
Also, on outgoing messages, Eudora can make sure that attachments are encoded
with the correct MIME type/subtype and/or Macintosh creator/type depending on
the file extension of the attachment being sent.

Eudora knows about some MIME types.  However, since new MIME types are
being defined all the time, it may be necessary to add to Eudora’s knowledge
from time to time.  Adding new mappings between the various types only
requires editing the EUDORA.INI file with a text editor.

There is a section in the EUDORA.INI file labelled [Mappings], followed by
some entries, one per line.  Each entry is called a map.  A map defines when the
mapping should occur (which can be “in,” “out,” or “both”), followed by an equal
sign and five parameters.  These five parameters are (in order) the PC file
extension, the Macintosh creator code, the Macintosh type, the MIME type, and
the MIME subtype.  Here are some sample entries:

[Mappings]

both=gif,,,image,gif

both=mpg,,,video,mpeg

both=doc,MSWD,,,

in=xls,XCEL,,,

out=xls,XCEL,XLS4,,

both=eps,,EPSF,application,postscript
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A map marked “in” only tries to match the map to messages that you receive.  A
map marked “out” only tries to match the map to messages that you send.  A map
marked “both” tries to match the map to both incoming and outgoing messages.

The first map says that any incoming MIME message that has a part type of
“image” and subtype of “gif” will get saved to a file with the extension “.gif.”  It
also specifies that outgoing messages that have an attachment with the file
extension “.gif” will get the MIME type of “image” and subtype of “gif” if the
encoding method of the message is MIME.  The second map is similar to the first
map in structure, but uses a different file extension and MIME type and subtype.

You can use map entries to move between PC file extensions and Macintosh
creator and type as well.  The third map says that if an incoming message has an
attachment with the Macintosh creator “MSWD” (which is the Macintosh creator
for Microsoft Word) then the file extension of the attachment when saved to disk
should be “.doc” (the file extension that Word for Windows uses).  Since the map
is marked as “both,” it will also give attachments with the extension “.doc” on
outgoing messages the Macintosh creator of “MSWD” if the encoding method of
the message is BinHex.

Note that the Macintosh type from this map is empty.  This allows multiple types
to be recognized with just one mapping.  The is nice for “in” maps because it
allows you to cover a range of creator/type pairs with one map.  You must be
careful in using this type of map with an “out” or “both” mapping, though,
because an outgoing attachment that matched this map would have a Macintosh
creator, but no Macintosh type.  Some Macintosh applications cannot open files
with a missing type.  Microsoft Word for the Macintosh can open files without a
type, so this map is fine being marked “both.”

Microsoft Excel for the Macintosh is an example of a program that can't open a
file with an empty type.  This is why there are two maps for Excel (the fourth and
fifth maps above).  The incoming map for Excel is like the one for Microsoft
Word, but the outgoing map explicitly defines the Macintosh type.

The last map shows that you can have both Macintosh creator/type and MIME
type/subtype in one entry.  This map says that if an incoming message has an
attachment that is encoded in MIME and has the “application/postscript”
type/subtype, or has a BinHex attachment with the Macintosh type of “EPSF,”
then the resulting file will have an extension of “.eps.”  Similarly, if an outgoing
message has an attachment with the extension “.eps” and if the MIME encoding is
being used for the message, then the attachment will get the
“application/postscript” MIME type/subtype.  If the message was using the
BinHex encoding, then the attachment would get the Macintosh type of “EPSF.”

But what happens if an attachment matches more than one map?  Eudora will try
and find the best match.  For example, if you had the following [Mappings]
section:

[Mappings]
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in=xls,XCEL,,,

in=xlc,XCEL,XLC3,,

and you received a message with an attachment that had a Macintosh creator of
“XCEL” and a Macintosh type of “XLC3” (a Microsoft Excel Chart), then the file
would get an extension of “.xlc” since the first map only matched the Macintosh
creator, but the second map matched both the Macintosh creator and type.

Eudora can receive attachments that have both a MIME type/subtype and a
Macintosh creator/type.  Eudora understands attachments with the MIME
type/subtype “application/applefile,” which has Macintosh creator/type
information embedded in it.  With this type of attachment, Eudora will consider a
match with the Macintosh creator/type as a “better” match than a match with the
MIME type/subtype.

Finally, if an incoming attachment matches two different maps to the same degree
(e.g., both maps have the same MIME type/subtype with different file
extensions), then Eudora will use the file extension in the first matching map.
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Index
Symbols

- message status, 43
;RFC 1725,, 118
???@???, 43
> markers, 20, 58
• In Nicknames window, 69, 72
• message status, 43

A

Add As Recipient command, 72
Advanced Network settings, 98
Alerts

Disabling, 95
Timing out, 98

Alt+arrow keys option, 97
Arrow keys, 97

Composition windows and, 97
Attach File command, 53
Attachment Directory setting, 91
Attachment Type

Button in icon bar, 28
Attachments, 53

And duplicate names, 56
Detaching, 55
Multiple, 55
Receiving, 55
Receiving automatically, 91

Attachments settings, 90
Authentication Style option, 89
Automatically open next message option, 98

B

Bcc button, 68
Bin Hex, 28
BinHex, 56

And plain TEXT documents, 54
Bounced mail, 79

C

Cache network info option, 99

Cc button, 68
Change Password... command, 36
Change Queueing... command, 33, 34
Check for mail setting, 88
Check Mail command, 37, 38
Checking mail, 16, 36, 88, 90

Automatic, 37
Minimum interval, 37

Automatically opening a mailbox, 95
Entering password, 16, 35
Manual, 38
Sound on new mail, 95
Stopping, 40

Checking Mail settings, 87
Clear command, 55
Close messages with mailbox option, 98
Commas, 63, 73
Compact Mailboxes command, 45
Composition window, 14
Copy original’s priority to reply option, 97
Current message, 19

D

D message status, 43, 60
Delete command, 23, 45
Delete key, 55
Don’t transfer, just create button, 47

E

Easy Delete option, 45
Edit menu, 103
Empty Trash command, 23, 45
Empty Trash on Quit option, 45
Empty Trash when exiting option, 98
Encoding Method option, 91
Enter key, 44
Enter Selection command, 77
Errors

Bounced mail, 79
Eudora Information, 111
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F

F Message status, 43, 59
Field, 14
File menu, 102
Find, 73

Match Case option, 76
Multiple messages, 76
Next button, 76
Next Mailbox button, 76
Next Message button, 76
Stopping, 77
Summaries Only option, 76
Within a message, 74

Find button, 74, 75
Finger, 82

Setting server, 87
Using Ph window for, 83

Finger button, 83
Finger setting, 87
Finish Nickname command, 70
Fix curly quotes option, 90
Font settings

for printing, 93
For screen, 92

Fonts & Display settings, 92
Forget Password command, 36
Forward command, 58
Forward To submenu, 73
ftp.qualcomm.com, 111

G

Getting Attention settings, 95
Getting Started settings, 85
Guess Paragraphs option, 78

H

Help, 14
Menu, 109

Hosts settings, 86

I

Icon bar, 27
Attachment Type combo box, 28
Keep Copy, 28

Priority combo box, 28
Queue button, 29
Quoted-Printable, 28
Send button, 29
Signature combo box, 28
Tabs in Body, 28
Text As Document, 28
Word-Wrap, 28

Icon bar, Incoming Message Window
Priority popup, 44
Subject, 44

Ignoring previously read messages, 39
Immediate Send option, 32, 90
In mailbox, 37, 39
Include Headers option, 78
Include Self option, 68
Include yourself option, 58
Insert Recipient submenu, 73

K

Keep Copies, 34
Button in icon bar, 28

Keep Copies of Outgoing Mail option, 90

L

Leave mail on server option, 39

M

Mail folder
Creating, 40
Creating during transfer, 47
Creating with the Mailboxes window, 51

Mail Storage, 100
Mailboxes, 100

Contents, 100
Mailbox

Compacting, 45
Thresholds for automatic, 45

Creating, 40
Creating during transfer, 21
Creating mailboxes in folders, 41
Creating with Mailboxes window, 51
Mailbox window

Disjoint selection in, 42
Range selection in, 42
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Moving with Mailboxes window, 52
Opening, 41
Opening a message from, 19
Opening on new mail, 95
Transferring messages between, 21, 46

Copying during, 46
Creating mail folders during, 47
Creating mailboxes during, 46

Waste space in, 45
Mailbox menu, 104, 106
Mailboxes command, 48
Mailboxes window, 47

Creating a mail folder with, 51
Creating a mailbox with, 51
Moving a mailbox with, 52
Moving around in, 48
New button, 51
Opening a mailbox from, 48
Remove button, 50
Removing mail folders with, 49
Removing mailboxes with, 49
Rename button, 51
Renaming a mail folder with, 51
Renaming a mailbox with, 51
Selecting multiple mailboxes, 50

Mailing list, 64, 66, 67
Make it a Folder button, 41, 47
Make Nickname command, 66

Using in Nicknames window, 66
Using with current messages, 67

Match Case option, 76
May use Quoted-Printable setting, 90
Menu cursor, 69, 71
Message

Closing, 98
Deleting, 23, 45

Unread/Queued, 45, 98
Incoming, 20

Forwarding, 58
Redirecting, 60
Redirecting & From field, 61
Replying to, 20, 57
Replying to all, 58, 96

CC original To recipients, 58
Include yourself, 58

Replying to all, but not self, 96

Sending again, 79
To field, 60
Window, 44

Icon Bar, 44
Message Body, 44
Title Bar, 44

Zooming windows, 93
Outgoing, 14, 27

Adding addressees to with
Nicknames window, 68
Addressing with Quick Recipient
list, 73
Attachments field, 29, 54, 55
Bcc field, 29
Body, 29, 30
Cc field, 29
Changing status of, 34
Closing, 31, 34
Creating, 27
Creating from Nicknames window,
68
Deleting, 31
From field, 14, 29, 59, 60
Header, 29
Saving, 21, 30, 32
Sending, 15, 31
Sending, one-step, 31
Sending, two-step, 32
Subject field, 15, 29
To field, 29, 57, 58
Zooming window, 93

Priority, 80
Transferring, 46

Copying during, 46
Creating mail folders during, 47
Creating mailboxes during, 46

Message menu, 105
Message Summary, 18, 42

Changing subject of, 81
Date in, 43
Priority of messages, 43
Sender/Recipient in, 43
Size in, 43
Status of message, 43

Forwarded, 43
Not sendable, 43
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Queued, 32
Read, 43
Redirected, 43
Replied, 43
Sendable, 30, 43
Sent, 35, 43
Timed, 33
Unread, 37, 39, 43
Unsent, 43

Subject in, 43
Message Window Height setting, 93
Message Window Width setting, 93
Messages

Incoming
Recombining split messages, 79

Outgoing
Attaching file to, 53
Timed, 33

Saving to files, 78
Using Redirect to repeat, 61

MIME, 28, 120
Base64 encoding, 120
Content-type header, 121
Macintosh creators, 122
Macintosh types, 122
Mapping, 122
Quoted-printable encoding, 120
Types, 122

Miscellaneous settings, 97
Move button, 52
Multipurpose Internet Mail Extensions, 28,
120

N

Network buffer size of ? bytes option, 99
Network timeout after ? seconds option, 99
New Message command, 14, 27
New Message To submenu, 73
New... command, 21, 40, 41, 46, 47
Next button, 76
Next command, 76
Next Mailbox button, 76
Next Mailbox command, 76
Next Message button, 76
Next Message command, 76
Next message, going to, 97

Next time_ button, 33
Nicknames, 62

Changing existing, 66
Expansion, 62
Putting on recipient, 69
Putting on recipient list, 66, 69, 72
Removing, 66
Removing and Quick Recipient list, 70
Removing from Quick Recipient list, 70,
72
Renaming and Quick Recipient list, 70
Saving, 65, 66
vs Quick Recipient list, 69

Nicknames window
Adding names to nicknames, 63
Adding nicknames, 62
Address(es) box, 62, 63
New button, 62
Notes box, 62, 64
Using to add addressees to message, 68
Using to send mail, 68

Nicknames... command, 62
o In Nicknames window, 69, 72
o message status, 43

O

On or After button, 33
Open mailbox option, 95
Out Mailbox, 21, 30, 34, 35
Outgoing message window, 27

P

Password
Changing, 36

Server source code for, 111
Entering, 16, 35
Forgetting, 36
Remembering, 36
Saving, 36, 88

Personal Information settings, 86
Ph, 82

Ph command field, 82
Ph Server field, 82
Server source code, 111
Setting server, 87
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Using Ph window for, 83
Ph button, 83
Ph setting, 87
Play a sound option, 95
POP, 36

Server for, 111
UNIX, 111
VAX/VMS, 111
VM/CMS, 111

POP Account setting, 12, 36, 85, 86, 88
POP server, 39, 117
POP3, 117
Popper, 111
Print... command, 100

Font settings, 93
Priority, 80

And Reply, 81
Priority Popup

Icon in icon bar, 44
Progress window, 15
Put it on the recipient list button, 63
Put text attachments in body of message
option, 54, 91

Q

Queue button, 32
Queue For Delivery command, 32, 34
Quick Recipient list, 70

Adding email address to, 72
Adding existing nickname to, 66, 69, 71,
72
Adding new nickname to, 63
Removing entry from, 73
vs Nicknames, 69

Quit command
And emptying Trash, 45
With queued messages, 33
With timed messages, 34

Quitting, 100
Quoted-Printable

Button in icon bar, 28
Turning off, 122

R

R message status, 43, 58

Real Name setting, 12, 85, 86
Redirect command, 60, 61
Redirect To submenu, 73
Rejected Mail, 79
Remove all button, 50
Remove it button, 50
Remove Recipient command, 73
Removing a nickname, 66
Removing mail folders, 49
Removing mailboxes, 49
Renaming a mail folder, 51
Renaming a mailbox, 51
Reply, 20
Reply command, 57, 58
Reply to all By default option, 58
Reply to all option, 96

Shift key and, 96
Reply To submenu, 73
Replying settings, 96
Require confirmation for delete option, 98
Requirements, 11
Return address, 14
Return address setting, 86, 89
Right Now button, 33

S

S message status, 43
Save As... command, 78
Save command, 21, 30, 65, 66
Save password option, 36, 88
Say OK to alerts after ? seconds option, 98
Send Again command, 80
Send button, 15, 31, 90
Send on check option, 88, 90
Send Queued Messages command, 32

Avoiding, 33
Sending mail, 88, 90
Sending Mail settings, 89
Serial Line IP (SLIP), 112
Settings

Advanced Network, 98
Attachments, 90
Checking Mail, 87
Dialog, 84
Fonts & Display, 92
Getting Attention, 95
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Getting Started, 85
Hosts, 86
Miscellaneous, 97
Personal Information, 86
Replying, 96
Sending Mail, 89

Settings... command, 12
Sharing a PC, 101
Show all headers option, 93
Show category icons option, 93
Show status bar option, 93
Show toolbar option, 93
Show toolbar tips option, 93
Signature, 83

And redirect, 61
Enabling/disabling, 90
Icon in icon bar, 28
Menu command, 83

Simple Mail Transfer Protocol, 117
Skip big messages option, 40
Skip messages over ? K option, 88
SLIP, 112
SMTP, 117, 118, 120
SMTP server setting, 89
SMTP setting, 87
Sorting, 77

By date, 78
Multiple criteria, 78

Special menu, 107
Subject

Changing, 81
Summaries Only option, 76
Switch messages with settings, 97

T

Tab key
Switching fields with, 28, 29

Tabs
Button in icon bar, 28
Replaced with spaces, 28

Tabs in body of message option, 90
Text As Document

Button in icon bar, 28
Title bar, 27
To button, 68
Toolbar

Forward Button, 26
Nicknames Button, 26
Print Button, 26
Redirect Button, 26
Reply Button, 26

Trash mailbox, 23, 45, 98

U

UNIX mail, 100
Unmodified arrow keys option, 97
Use an alert dialog box option, 95
Use asynchronous Winsock calls for option,
99
Use Directory button, 56
Use signature option, 90

W

When replying to all option, 96
Window menu, 108
Windows Sockets, 111
Word Wrap, 30, 90

Button in icon bar, 28
Word wrap option, 90

X

X-Priority field, 81

Z

Zoom windows when opening option, 93


